QGIS Server 3.16 User Guide

QGIS Project

30 mai. 2021
1 Introdução

2 Iniciando

2.1 Installation on Debian-based systems

2.1.1 Apache HTTP Server

2.1.2 NGINX HTTP Server

2.1.3 Xvfb

2.2 Installation on Windows

2.3 Serve a project

2.4 Configure your project

2.4.1 WMS capabilities

2.4.2 WFS capabilities

2.4.3 WCS capabilities

2.4.4 Fine tuning your OWS

2.5 Integration with third parties

2.5.1 Integration with QGIS Desktop

2.5.2 Integration with MapProxy

2.5.3 Integration with QWC2

3 Services

3.1 Web Map Service (WMS)

3.1.1 GetMap

3.1.2 GetFeatureInfo

3.1.3 GetPrint

3.1.4 GetLegendGraphics

3.1.5 GetProjectSettings

3.2 Web Feature Service (WFS)

3.2.1 GetFeature

3.3 Web Map Tile Service (WMTS)

3.3.1 GetCapabilities

3.3.2 GetTile

3.3.3 GetFeatureInfo

3.4 WFS3 (OGC API Features)

3.4.1 Resource representation

3.4.2 Endpoints

3.4.3 Pagination

3.4.4 Feature filtering

3.4.5 Feature sorting

3.4.6 Attribute selection

3.4.7 The HTML template language

3.5 Extra parameters supported by all request types
3.6 REDLINING .................................................. 49
3.7 External WMS layers ........................................... 51
3.8 QGIS Server catalog .......................................... 51

4 Plugins ......................................................... 55
  4.1 Instalação .................................................. 55
  4.2 Configuração do Servidor HTTP ......................... 55
    4.2.1 Apache ............................................... 55
  4.3 How to use a plugin ...................................... 56

5 Configuração avançada ...................................... 57
  5.1 Registrando ................................................ 57
  5.2 Variáveis ambientais ...................................... 57
  5.3 Settings summary ........................................ 59
  5.4 Short name for layers, groups and project ............ 60
  5.5 Connection to service file .............................. 60
  5.6 Add fonts to your linux server .......................... 60

6 Development Server ........................................ 63

7 Containerized deployment .................................. 65
  7.1 Simple docker images .................................... 65
    7.1.1 First run ............................................ 67
    7.1.2 Usable sample ....................................... 67
    7.1.3 Cleanup .............................................. 68
  7.2 Docker stacks ............................................ 68
    7.2.1 Swarm/docker-compose ................................ 68
    7.2.2 Kubernetes .......................................... 69
  7.3 Cloud deployment ....................................... 72
    7.3.1 AWS usecase ......................................... 73

8 Frequently Asked Question ................................ 75
QGIS Server is an open source WMS, WFS, OGC API for Features 1.0 (WFS3) and WCS implementation that, in addition, implements advanced cartographic features for thematic mapping. QGIS Server is a FastCGI/CGI (Common Gateway Interface) application written in C++ that works together with a web server (e.g., Apache, Nginx). It has Python plugin support allowing for fast and efficient development and deployment of new features.

QGIS Server uses QGIS as back end for the GIS logic and for map rendering. Furthermore, the Qt library is used for graphics and for platform-independent C++ programming. In contrast to other WMS software, the QGIS Server uses cartographic rules as a configuration language, both for the server configuration and for the user-defined cartographic rules.

Como o desktop QGIS e o Servidor QGIS usam as mesmas bibliotecas de visualização, os mapas que são publicados na web têm a mesma aparência do desktop GIS.

In the following sections, we will provide a sample configuration to set up a QGIS Server on Linux (Debian, Ubuntu and derivatives) and on Windows. For more information about server plugin development, please read server_plugins.
2.1 Installation on Debian-based systems

We will give a short and simple installation how-to for a minimal working configuration on Debian based systems (including Ubuntu and derivatives). However, many other distributions and OSs provide packages for QGIS Server. 

Requirements and steps to add official QGIS repositories to install current QGIS Server on a Debian based system are provided in QGIS installers page.

Nota: No Ubuntu, você pode usar seu usuário comum, acrescentando sudo aos comandos que requerem permissões de administrador. No Debian você pode trabalhar como administrador (root), sem usar sudo.

We strongly suggest installing the LTR version.

Once the chosen repository is configured, installation is simply done with:

```
apt install qgis-server --no-install-recommends --no-install-suggests
# if you want to install server Python plugins, also:
apt install python-qgis
```

To test the installation, run:

```
/usr/lib/cgi-bin/qgis_mapserv.fcgi
```

If you get the following output, the server is correctly installed

```
QFSFileEngine::open: No file name specified
Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver JP2ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver JP2ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver JP2ECW to unload from GDAL_SKIP environment variable.
Content-Length: 206
Content-Type: text/xml; charset=utf-8
```
Let's add a sample project. You can use your own, or one from Training demo data:

```
mkdir /home/qgis/projects/
cd /home/qgis/projects/
wget https://github.com/qgis/QGIS-Training-Data/archive/v2.0.zip
unzip v2.0.zip
mv QGIS-Training-Data-2.0/exercise_data/qgis-server-tutorial-data/world.qgs .
mv QGIS-Training-Data-2.0/exercise_data/qgis-server-tutorial-data/naturalearth.sqlite .
```

Of course, you can use your favorite GIS software to open this file and take a look at the configuration and available layers.

To properly deploy QGIS server you need a HTTP server. Recommended choices are Apache or NGINX.

### 2.1.1 Apache HTTP Server

**Nota:** In the following, please replace localhost with the name or IP address of your server.

Install Apache and mod_fcgid:

```
apt install apache2 libapache2-mod-fcgid
```

You can run QGIS Server on your default website, or configure a virtualhost specifically for this, as follows.

In the /etc/apache2/sites-available directory let’s create a file called qgis.demo.conf, with this content:

```
<VirtualHost *:80>
  ServerAdmin webmaster@localhost
  ServerName qgis.demo
  DocumentRoot /var/www/html

  # Apache logs (different than QGIS Server log)
  ErrorLog ${APACHE_LOG_DIR}/qgis.demo.error.log
  CustomLog ${APACHE_LOG_DIR}/qgis.demo.access.log combined

  # Longer timeout for WPS... default = 40
  FcgidIOTimeout 120

  FcgidInitialEnv LC_ALL "en_US.UTF-8"
  FcgidInitialEnv PYTHONIOENCODING UTF-8
  FcgidInitialEnv LANG "en_US.UTF-8"

  # QGIS log
  FcgidInitialEnv QGIS_SERVER_LOG_STDERR 1
  FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0

  # default QGIS project
  SetEnv QGIS_PROJECT_FILE /home/qgis/projects/world.qgs

  # QGIS_AUTH_DB_DIR_PATH must lead to a directory writeable by the Server’s FCGI...
  FcgidInitialEnv QGIS_AUTH_DB_DIR_PATH /var/www/html/qgis
</VirtualHost>
```

(continua na próxima página)
FcgidInitialEnv QGIS_AUTH_DB_DIR_PATH "/home/qgis/qgisserverdb/"
FcgidInitialEnv QGIS_AUTH_PASSWORD_FILE "/home/qgis/qgisserverdb/qgis-auth.db"

# Set pg access via pg_service file
SetEnv PGSERVICEFILE /home/qgis/.pg_service.conf
FcgidInitialEnv PGPASSFILE "/home/qgis/.pgpass"

# if qgis-server is installed from packages in debian based distros this is usually /usr/lib/cgi-bin/
# run "locate qgis_mapserv.fcgi" if you don't know where qgis_mapserv.fcgi is
ScriptAlias /cgi-bin/ /usr/lib/cgi-bin/

<Directory "/usr/lib/cgi-bin/">
    AllowOverride None
    Options +ExecCGI -MultiViews -SymLinksIfOwnerMatch
    Order allow,deny
    Allow from all
    Require all granted
</Directory>

<IfModule mod_fcgid.c>
    FcgidMaxRequestLen 26214400
    FcgidConnectTimeout 60
</IfModule>

</VirtualHost>

Further readings:

- **QGIS Server logging**
- pg-service-file in QGIS Server

You can do the above in a Linux Desktop system by pasting and saving the above configuration after doing:

```
nano /etc/apache2/sites-available/qgis.demo.conf
```

**Nota:** Some of the configuration options are explained in the Server *environment variables* section.

Let’s now create the directories that will store the QGIS Server logs and the authentication database:

```
mkdir -p /var/log/qgis/
chown www-data:www-data /var/log/qgis
mkdir -p /home/qgis/qgisserverdb
chown www-data:www-data /home/qgis/qgisserverdb
```

**Nota:** `www-data` is the Apache user on Debian-based systems and we need Apache to have access to those locations or files. The `chown` commands change the owner of the respective directories and files to `www-data`.

We can now enable the virtual host, enable the fcgid mod if it’s not already enabled:

```
a2enmod fcgid
a2ensite qgis.demo
```

Now restart Apache for the new configuration to be taken into account:

```
systemctl restart apache2
```

---

2.1. **Installation on Debian-based systems**
Now that Apache knows that he should answer requests to http://qgis.demo we also need to setup the client system so that it knows who qgis.demo is. We do that by adding 127.0.0.1 qgis.demo in the hosts file. We can do it with sh -c "echo '127.0.0.1 qgis.demo' >> /etc/hosts". Replace 127.0.0.1 with the IP of your server.

Nota: Remember that both the myhost.conf and /etc/hosts files should be configured for your setup to work. You can also test the access to your QGIS Server from other clients on the network (e.g. Windows or macOS machines) by going to their /etc/hosts file and point the myhostname name to whatever IP the server machine has on the network (not 127.0.0.1 as it is the local IP, only accessible from the local machine). On *nix machines the hosts file is located in /etc, while on Windows it’s under the C:\Windows\System32\drivers\etc directory. Under Windows you need to start your text editor with administrator privileges before opening the hosts file.

QGIS Server is now available at http://localhost/qgisserver. To check, type in a browser, as in the simple case:

```
http://localhost/qgisserver/cgi-bin/qgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities
```

### 2.1.2 NGINX HTTP Server

Nota: In the following, please replace localhost with the name or IP address of your server.

You can also use QGIS Server with NGINX. Unlike Apache, NGINX does not automatically spawn FastCGI processes. The FastCGI processes are to be started by something else.

Install NGINX:

```
apt install nginx
```

- As a first option, you can use spawn-fcgi or fcgiwrap to start and manage the QGIS Server processes. Official Debian packages exist for both. When you have no X server running and you need, for example, printing, you can use xvfb.
- Another option is to rely on Systemd, the init system for GNU/Linux that most Linux distributions use today. One of the advantages of this method is that it requires no other components or processes. It’s meant to be simple, yet robust and efficient for production deployments.

### NGINX Configuration

The include fastcgi_params; used in the previous configuration is important, as it adds the parameters from /etc/nginx/fastcgi_params:

<table>
<thead>
<tr>
<th>fastcgi_param</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QUERY_STRING</td>
<td>$query_string;</td>
</tr>
<tr>
<td>REQUEST_METHOD</td>
<td>$request_method;</td>
</tr>
<tr>
<td>CONTENT_TYPE</td>
<td>$content_type;</td>
</tr>
<tr>
<td>CONTENT_LENGTH</td>
<td>$content_length;</td>
</tr>
<tr>
<td>SCRIPT_NAME</td>
<td>$fastcgi_script_name;</td>
</tr>
<tr>
<td>REQUEST_URI</td>
<td>$request_uri;</td>
</tr>
<tr>
<td>DOCUMENT_URI</td>
<td>$document_uri;</td>
</tr>
<tr>
<td>DOCUMENT_ROOT</td>
<td>$document_root;</td>
</tr>
<tr>
<td>SERVER_PROTOCOL</td>
<td>$server_protocol;</td>
</tr>
<tr>
<td>REQUEST_SCHEME</td>
<td>$scheme;</td>
</tr>
<tr>
<td>HTTPS</td>
<td>$https if_not_empty;</td>
</tr>
<tr>
<td>GATEWAY_INTERFACE</td>
<td>CGI/1.1;</td>
</tr>
</tbody>
</table>

(continua na próxima página)
Moreover, you can use some Variáveis ambientais to configure QGIS Server. In the NGINX configuration file, /etc/nginx/nginx.conf, you have to use fastcgi_param instruction to define these variables as shown below:

```conf
location /qgisserver {
    gzip off;
    include fastcgi_params;
    fastcgi_param QGIS_SERVER_LOG_STDERR 1;
    fastcgi_param QGIS_SERVER_LOG_LEVEL 0;
    fastcgi_pass unix:/var/run/qgisserver.socket;
}
```

**FastCGI wrappers**

*Aviso: fcgiwrap* is easier to set up than *spawn-fcgi*, because it's already wrapped in a Systemd service. But it also leads to a solution that is much slower than using spawn-fcgi. With fcgiwrap, a new QGIS Server process is created on each request, meaning that the QGIS Server initialization process, which includes reading and parsing the QGIS project file, is done on each request. With spawn-fcgi, the QGIS Server process remains alive between requests, resulting in much better performance. For that reason, spawn-fcgi is recommended for production use.

**spawn-fcgi**

If you want to use spawn-fcgi, the first step is to install the package:

```bash
apt install spawn-fcgi
```

Then, introduce the following block in your NGINX server configuration:

```conf
location /qgisserver {
    gzip off;
    include fastcgi_params;
    fastcgi_pass unix:/var/run/qgisserver.socket;
}
```

And restart NGINX to take into account the new configuration:

```bash
systemctl restart nginx
```

Finally, considering that there is no default service file for spawn-fcgi, you have to manually start QGIS Server in your terminal:

```bash
spawn-fcgi -s /var/run/qgisserver.socket \
    -U www-data -G www-data -n \
    /usr/lib/cgi-bin/qgis_mapserv.fcgi
```
QGIS Server 3.16 User Guide

QGIS Server is now available at http://localhost/qgisserver.

Nota: When using spawn-fcgi, you may directly define environment variables before running the server. For example: export QGIS_SERVER_LOG_STDERR=1

Of course, you can add an init script to start QGIS Server at boot time or whenever you want. For example with systemd, edit the file /etc/systemd/system/qgis-server.service with this content:

```ini
[Unit]
Description=QGIS server
After=network.target

[Service]
;; set env var as needed
;Environment="LANG=en_EN.UTF-8"
;Environment="QGIS_SERVER_PARALLEL_RENDERING=1"
;Environment="QGIS_SERVER_MAX_THREADS=12"
;Environment="QGIS_SERVER_LOG_LEVEL=0"
;Environment="QGIS_SERVER_LOG_STDERR=1"
;; or use a file:
;EnvironmentFile=/etc/qgis-server/env

[Install]
WantedBy=multi-user.target
```

Then enable and start the service:

```
systemctl enable --now qgis-server
```

Aviso: With the above commands spawn-fcgi spawns only one QGIS Server process.

fcgiwrap

Using fcgiwrap is much easier to setup than spawn-fcgi but it’s much slower. You first have to install the corresponding package:

```
apt install fcgiwrap
```

Then, introduce the following block in your NGINX server configuration:

```ini
location /qgisserver {
    gzip off;
    include fastcgi_params;
    fastcgi_pass unix:/var/run/fcgiwrap.socket;
    fastcgi_param SCRIPT_FILENAME /usr/lib/cgi-bin/qgis_mapserv.fcgi;
}
```

Finally, restart NGINX and fcgiwrap to take into account the new configuration:

```
systemctl restart nginx
systemctl restart fcgiwrap
```

QGIS Server is now available at http://localhost/qgisserver.
Systemd

QGIS Server needs a running X Server to be fully usable, in particular for printing. In the case you already have a running X Server, you can use systemd services.

This method, to deploy QGIS Server, relies on two Systemd units:

- a Socket unit
- and a Service unit.

The **QGIS Server Socket unit** defines and creates a file system socket, used by NGINX to start and communicate with QGIS Server. The Socket unit has to be configured with `Accept=false`, meaning that the calls to the `accept()` system call are delegated to the process created by the Service unit. It is located in `/etc/systemd/system/qgis-server@.socket`, which is actually a template:

```text
[Unit]
Description=QGIS Server Listen Socket (instance %i)

[Socket]
Accept=false
ListenStream=/var/run/qgis-server-%i.sock
SocketUser=www-data
SocketGroup=www-data
SocketMode=0600

[Install]
WantedBy=sockets.target
```

Now enable and start sockets:

```bash
for i in 1 2 3 4; do systemctl enable --now qgis-server@$i.socket; done
```

The **QGIS Server Service unit** defines and starts the QGIS Server process. The important part is that the Service process’ standard input is connected to the socket defined by the Socket unit. This has to be configured using `StandardInput=socket` in the Service unit configuration located in `/etc/systemd/system/qgis-server@.service`:

```text
[Unit]
Description=QGIS Server Service (instance %i)

[Service]
User=www-data
Group=www-data
StandardOutput=null
StandardError=journal
StandardInput=socket
ExecStart=/usr/lib/cgi-bin/qgis_mapserv.fcgi
EnvironmentFile=/etc/qgis-server/env

[Install]
WantedBy=multi-user.target
```

**Nota:** The QGIS Server environment variables are defined in a separate file, `/etc/qgis-server/env`. It could look like this:

```text
QGIS_PROJECT_FILE=/etc/qgis/myproject.qgs
QGIS_SERVER_LOG_STDERR=1
QGIS_SERVER_LOG_LEVEL=3
```

Now start socket service:
Finally, for the NGINX HTTP server, let's introduce the configuration for this setup:

```plaintext
upstream qgis-server_backend {
    server unix:/var/run/qgis-server-1.sock;
    server unix:/var/run/qgis-server-2.sock;
    server unix:/var/run/qgis-server-3.sock;
    server unix:/var/run/qgis-server-4.sock;
}

server {
    location /qgis-server {
        gzip off;
        include fastcgi_params;
        fastcgi_pass qgis-server_backend;
    }
}
```

Now restart NGINX for the new configuration to be taken into account:

```plaintext
systemctl restart nginx
```

Thanks to Oslandia for sharing their tutorial.

### 2.1.3 Xvfb

QGIS Server needs a running X Server to be fully usable, in particular for printing. On servers it is usually recommended not to install it, so you may use `xvfb` to have a virtual X environment.

If you’re running the Server in graphic/X11 environment then there is no need to install xvfb. More info at [https://www.itopen.it/qgis-server-setup-notes/](https://www.itopen.it/qgis-server-setup-notes/).

To install the package:

```plaintext
apt install xvfb
```

Create the service file, `/etc/systemd/system/xvfb.service`, with this content:

```plaintext
[Unit]
Description=X Virtual Frame Buffer Service
After=network.target

[Service]
ExecStart=/usr/bin/Xvfb :99 -screen 0 1024x768x24 -ac +extension GLX +render -noreset

[Install]
WantedBy=multi-user.target
```

Activate, inici e verifique o status do `xvfb.service`:

```plaintext
systemctl enable --now xvfb.service
systemctl status xvfb.service
```

Then, according to your HTTP server, you should configure the `DISPLAY` parameter or directly use `xvfb-run`.
With Apache

Then you can configure the `DISPLAY` parameter.

With Apache you just add to your FastCGI configuration (see above):

```
FcgidInitialEnv DISPLAY ":99"
```

Now restart Apache for the new configuration to be taken into account:

```
systemctl restart apache2
```

With NGINX

Then you can directly use `xvfb-run` or configure the `DISPLAY` parameter.

- With spawn-fcgi using `xvfb-run`:

  ```
xvfb-run /usr/bin/spawn-fcgi -f /usr/lib/cgi-bin/qgis_mapserv.fcgi \
  -s /tmp/qgisserver.socket \n  -G www-data -U www-data -n
  
  fastcgi_param DISPLAY ":99";
  ```

- With the `DISPLAY` environment variable in the HTTP server configuration.

2.2 Installation on Windows

QGIS Server can also be installed on Windows systems. While the QGIS Server package is available in the 64 bit version of the OSGeo4W network installer (https://qgis.org/en/site/forusers/download.html) there is no Apache (or other web server) package available, so this must be installed by other means.

A simple procedure is the following:

- Download the XAMPP installer (https://www.apachefriends.org/download.html) for Windows and install Apache
• Download the OSGeo4W installer, follow the “Advanced Install” and install both the QGIS Desktop and QGIS Server packages.

• Edit the httpd.conf file (C:\xampp\apache\conf\httpd.conf if the default installation paths have been used) and make the following changes:

From:
ScriptAlias /cgi-bin/ "C:/xampp/cgi-bin/"

To:

ScriptAlias /cgi-bin/ "C:/OSGeo4W64/apps/qgis/bin/"

From:

<Directory "C:/xampp/cgi-bin">
  AllowOverride None
  Options None
  Require all granted
</Directory>

To:

<Directory "C:/OSGeo4W64/apps/qgis/bin">
  SetHandler cgi-script
  AllowOverride None
  Options ExecCGI
  Order allow,deny
  Allow from all
  Require all granted
</Directory>

Then at the bottom of httpd.conf add:

SetEnv GDAL_DATA "C:\OSGeo4W64\share\gdal"
SetEnv QGIS_AUTH_DB_DIR_PATH "C:\OSGeo4W64\apps\qgis\resources"
SetEnv PYTHONHOME "C:\OSGeo4W64\apps\Python37"
SetEnv PATH "C:\OSGeo4W64\bin;C:\OSGeo4W64\apps\qgis\bin;C:\OSGeo4W64\apps\Qt5\bin;"+"C:\WINDOWS\system32;C:\WINDOWS;C:\WINDOWS\System32\Wbem"
SetEnv QGIS_PREFIX_PATH "C:\OSGeo4W64\apps\qgis"
SetEnv QT_PLUGIN_PATH "C:\OSGeo4W64\apps\qgis\qtplugins;C:\OSGeo4W64\apps\Qt5\"+"plugins"

Restart the Apache web server from the XAMPP Control Panel and open browser window to testing a GetCapabilities request to QGIS Server

http://localhost/cgi-bin/qgis_mapserv.fcgi.exe?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities

2.2. Installation on Windows
2.3 Serve a project

Now that QGIS Server is installed and running, we just have to use it.

Obviously, we need a QGIS project to work on. Of course, you can fully customize your project by defining contact information, precise some restrictions on CRS or even exclude some layers. Everything you need to know about that is described later in Configure your project.

But for now, we are going to use a simple project already configured and previously downloaded in /home/qgis/projects/world.qgs, as described above.

By opening the project and taking a quick look on layers, we know that 4 layers are currently available:

- airports
- places
- countries
- countries_shapeburst

You don’t have to understand the full request for now but you may retrieve a map with some of the previous layers thanks to QGIS Server by doing something like this in your web browser to retrieve the countries layer:

```
http://localhost/qgisserver?
MAP=/home/qgis/projects/world.qgs&
LAYERS=countries&
SERVICE=WMS&
REQUEST=GetMap&
CRS=EPSG:4326&
WIDTH=400&
HEIGHT=200
```

If you obtain the next image, then QGIS Server is running correctly:

![Server response to a basic GetMap request](image)

Fig. 2.1: Server response to a basic GetMap request

Note that you may define QGIS_PROJECT_FILE environment variable to use a project by default instead of giving a MAP parameter (see Variáveis ambientais).

Por exemplo com spawn-fcgi:

```
export QGIS_PROJECT_FILE=/home/qgis/projects/world.qgs
spawn-fcgi -f /usr/lib/bin/cgi-bin/qgis_mapserv.fcgi \
    -s /var/run/qgisserver.socket \
    -U www-data -G www-data -n
```
2.4 Configure your project

To provide a new QGIS Server WMS, WFS or WCS, you have to create a QGIS project file with some data or use one of your current project. Define the colors and styles of the layers in QGIS and the project CRS, if not already defined.

Then, go to the QGIS Server menu of the Project ➤ Properties... dialog and provide some information about the OWS in the fields under Service Capabilities. This will appear in the GetCapabilities response of the WMS, WFS or WCS. If you don’t check Service capabilities, QGIS Server will use the information given in the wms_metadata.xml
2.4.1 WMS capabilities

In the WMS capabilities section, you can define the extent advertised in the WMS GetCapabilities response by entering the minimum and maximum X and Y values in the fields under Advertised extent. Clicking Use Current Canvas Extent sets these values to the extent currently displayed in the QGIS map canvas. By checking CRS restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server will offer to render maps. It is recommended that you restrict the offered CRS as this reduces the size of the WMS GetCapabilities response. Use the button below to select those CRSs from the Coordinate Reference System Selector, or click Used to add the CRSs used in the QGIS project to the list.

If you have print layouts defined in your project, they will be listed in the GetProjectSettings response, and they can be used by the GetPrint request to create prints, using one of the print layouts as a template. This is a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print layout from being published by the WMS, check Exclude layouts and click the button below. Then, select a print layout from the Select print layout dialog in order to add it to the excluded layouts list.

If you want to exclude any layer or layer group from being published by the WMS, check Exclude Layers and click the button below. This opens the Select restricted layers and groups dialog, which allows you to choose the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want to select multiple entries. It is recommended that you exclude from publishing the layers that you don’t need as this reduces the size of the WMS GetCapabilities response which leads to faster loading times on the client side.

If you check Use layer ids as name, layer ids will be used to reference layers in the GetCapabilities response or GetMap LAYERS parameter. If not, layer name or short name if defined (see vectorservermenu) is used.

You can receive requested GetFeatureInfo as plaintext, XML and GML. The default is XML.

If you wish, you can check Add geometry to feature response. This will include the bounding box for each feature in the GetFeatureInfo response. See also the WITH_GEOMETRY parameter.

As many web clients can’t display circular arcs in geometries you have the option to segmentize the geometry before sending it to the client in a GetFeatureInfo response. This allows such clients to still display a feature’s geometry (e.g. for highlighting the feature). You need to check the Segmentize feature info geometry to activate the option.

You can also use the GetFeatureInfo geometry precision option to set the precision of the GetFeatureInfo geometry. This enables you to save bandwidth when you don’t need the full precision.

If you want QGIS Server to advertise specific request URLs in the WMS GetCapabilities response, enter the corresponding URL in the Advertised URL field.

Furthermore, you can restrict the maximum size of the maps returned by the GetMap request by entering the maximum width and height into the respective fields under Maximums for GetMap request.

You can change the Quality for JPEG images factor. The quality factor must be in the range 0 to 100. Specify 0 for maximum compression, 100 for no compression.

You can change the limit for atlas features to be printed in one request by setting the Maximum features for Atlas print requests field.

When QGIS Server is used in tiled mode (see TILED parameter), you can set the Tile buffer in pixels. The recommended value is the size of the largest symbol or line width in your QGIS project.

If one of your layers uses the Map Tip display (i.e. to show text using expressions) this will be listed inside the GetFeatureInfo output. If the layer uses a Value Map for one of its attributes, this information will also be shown in the GetFeatureInfo output.
2.4.2 WFS capabilities

In the WFS capabilities area you can select the layers you want to publish as WFS, and specify if they will allow update, insert and delete operations. If you enter a URL in the Advertised URL field of the WFS capabilities section, QGIS Server will advertise this specific URL in the WFS GetCapabilities response.

2.4.3 WCS capabilities

In the WCS capabilities area, you can select the layers that you want to publish as WCS. If you enter a URL in the Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific URL in the WCS GetCapabilities response.

2.4.4 Fine tuning your OWS

For vector layers, the Fields menu of the Layer ➤ Layer Properties dialog allows you to define for each attribute if it will be published or not. By default, all the attributes are published by your WMS and WFS. If you don’t want a specific attribute to be published, uncheck the corresponding checkbox in the WMS or WFS column.

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG annotations to the project file. See the sec_annotations section for instructions on creating annotations. For annotations to be displayed as watermarks on the WMS output, the Fixed map position checkbox in the Annotation text dialog must be unchecked. This can be accessed by double clicking the annotation while one of the annotation tools is active. For SVG annotations, you will need either to set the project to save absolute paths (in the General menu of the Project ➤ Properties... dialog) or to manually modify the path to the SVG image so that it represents a valid relative path.

2.5 Integration with third parties

QGIS Server provides standard OGC web services like WMS, WFS, etc. thus it can be used by a wide variety of end user tools.

2.5.1 Integration with QGIS Desktop

QGIS Desktop is the map designer where QGIS Server is the map server. The maps or QGIS projects will be served by the QGIS Server to provide OGC standards. These QGIS projects can either be files or entries in a database (by using Project ➤ Save to ➤ PostgreSQL in QGIS Desktop).

Furthermore, dedicated update workflow must be established to refresh a project used by a QGIS Server (ie. copy project files into server location and restart QGIS Server). For now, automated processes (as server reloading over message queue service) are not implemented yet.

2.5.2 Integration with MapProxy

MapProxy is a tile cache server and as it can read and serve any WMS/WMTS map server, it can be directly connected to QGIS server web services and improve end user experience.
2.5.3 Integration with QWC2

QWC2 is a responsive web application dedicated to QGIS Server. It helps you to build a highly customized map viewer with layer selection, feature info, etc. Also many plugins are available like authentication or print service, the full list is available is this repository.
QGIS Server is able to serve data according to standard protocols as described by the Open Geospatial Consortium (OGC):

- WMS 1.1.1 and 1.3.0
- WFS 1.0.0 and 1.1.0
- OGC API - Features (WFS3)
- WCS 1.1.1
- WMTS 1.0.0

Extra vendor parameters and requests are supported in addition to the original standard that greatly enhance the possibilities of customizing its behavior thanks to the QGIS rendering engine.

### 3.1 Web Map Service (WMS)

The 1.1.1 and 1.3.0 WMS standards implemented in QGIS Server provide a HTTP interface to request map or legend images generated from a QGIS project. A typical WMS request defines the QGIS project to use, the layers to render as well as the image format to generate. Basic support is also available for Styled Layer Descriptor (SLD).

Specifications:

- WMS 1.1.1
- WMS 1.3.0
- SLD 1.1.0 WMS profile

Standard requests provided by QGIS Server:

<table>
<thead>
<tr>
<th>Request</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetCapabilities</td>
<td>Returns XML metadata with information about the server</td>
</tr>
<tr>
<td>GetMap</td>
<td>Returns a map</td>
</tr>
<tr>
<td>GetFeatureInfo</td>
<td>Retrieves data (geometry and values) for a pixel location</td>
</tr>
<tr>
<td>GetLegendGraphics</td>
<td>Returns legend symbols</td>
</tr>
</tbody>
</table>

Vendor requests provided by QGIS Server:
3.1.1 GetMap

Standard parameters for the `GetMap` request according to the OGC WMS 1.1.1 and 1.3.0 specifications:

<table>
<thead>
<tr>
<th>Parâmetros</th>
<th>Requerido</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVICE</td>
<td>Sim</td>
<td>Name of the service (WMS)</td>
</tr>
<tr>
<td>VERSION</td>
<td>Não</td>
<td>Version of the service</td>
</tr>
<tr>
<td>REQUEST</td>
<td>Sim</td>
<td>Name of the request (<code>GetMap</code>)</td>
</tr>
<tr>
<td>LAYERS</td>
<td>Não</td>
<td>Layers to display</td>
</tr>
<tr>
<td>STYLES</td>
<td>Não</td>
<td>Layers' style</td>
</tr>
<tr>
<td>SRS / CRS</td>
<td>Sim</td>
<td>Coordinate reference system</td>
</tr>
<tr>
<td>BBOX</td>
<td>Não</td>
<td>Map extent</td>
</tr>
<tr>
<td>WIDTH</td>
<td>Sim</td>
<td>Width of the image in pixels</td>
</tr>
<tr>
<td>HEIGHT</td>
<td>Sim</td>
<td>Height of the image in pixels</td>
</tr>
<tr>
<td>FORMAT</td>
<td>Não</td>
<td>Image format</td>
</tr>
<tr>
<td>TRANSPARENT</td>
<td>Não</td>
<td>Transparent background</td>
</tr>
<tr>
<td>SLD</td>
<td>Não</td>
<td>URL of an SLD to be used for styling</td>
</tr>
<tr>
<td>SLD_BODY</td>
<td>Não</td>
<td>In-line SLD (XML) to be used for styling</td>
</tr>
</tbody>
</table>

In addition to the standard ones, QGIS Server supports the following extra parameters:

<table>
<thead>
<tr>
<th>Parâmetros</th>
<th>Requerido</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAP</td>
<td>Sim</td>
<td>Specify the QGIS project file</td>
</tr>
<tr>
<td>BGCOLOR</td>
<td>Não</td>
<td>Specify the background color</td>
</tr>
<tr>
<td>DPI</td>
<td>Não</td>
<td>Specify the output resolution</td>
</tr>
<tr>
<td>IMAGE_QUALITY</td>
<td>Não</td>
<td>JPEG compression</td>
</tr>
<tr>
<td>OPACITIES</td>
<td>Não</td>
<td>Opacity for layer or group</td>
</tr>
<tr>
<td>FILTER</td>
<td>Não</td>
<td>Subset of features</td>
</tr>
<tr>
<td>SELECTION</td>
<td>Não</td>
<td>Highlight features</td>
</tr>
<tr>
<td>FILE_NAME</td>
<td>Não</td>
<td>File name of the downloaded file</td>
</tr>
<tr>
<td>FORMAT_OPTIONS</td>
<td>Não</td>
<td>Options of the specified file format</td>
</tr>
<tr>
<td>TILED</td>
<td>Não</td>
<td>Working in <code>tiled mode</code></td>
</tr>
</tbody>
</table>

URL example:

```
http://localhost/qgis_server?
SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&MAP=/home/qgis/projects/world.qgs
&LAYERS=mylayer1,mylayer2,mylayer3
&STYLES=style1,default,style3
&OPACITIES=125,200,125
&CRS=EPSG:4326
&WIDTH=400
&HEIGHT=400
&FORMAT=image/png
&TRANSPARENT=TRUE
```
SERVICE

This parameter has to be `WMS`.

For example:

```
http://localhost/qgisserver?
SERVICE=WMS
&...
```

VERSION

This parameter allows to specify the version of the service to use. Available values for the `VERSION` parameter are:

- `1.1.1`
- `1.3.0`

If no version is indicated in the request, then `1.3.0` is used by default.

According to the version number, slight differences have to be expected as explained later for the next parameters:

- `CRS/SRS`
- `BBOX`

REQUEST

This parameter is `GetMap` in case of the `GetMap` request.

LAYERS

This parameter allows to specify the layers to display on the map. Names have to be separated by a comma.

In addition, QGIS Server introduced some options to select layers by:

- a short name
- the layer id

The short name of a layer may be configured through `Properties ➤ Metadata` in layer menu. If the short name is defined, then it's used by default instead of the layer's name:

```
http://localhost/qgisserver?
SERVICE=WMS
&REQUEST=GetMap
&LAYERS=mynickname1,mynickname2
&...
```

Moreover, there's a project option allowing to select layers by their id in `OWS Server ➤ WMS capabilities` menu of the `Project ➤ Properties...` dialog. To activate this option, the checkbox `Use layer ids as names` has to be selected.

```
http://localhost/qgisserver?
SERVICE=WMS
&REQUEST=GetMap
&LAYERS=mylayerid1,mylayerid2
&...
```
STYLES

This parameter can be used to specify a layer’s style for the rendering step. Styles have to be separated by a comma. The name of the default style is default.

SRS / CRS

This parameter allows to indicate the map output Spatial Reference System in WMS 1.1.1 and has to be formed like EPSG:XXXX. Note that CRS is also supported if current version is 1.1.1.

For WMS 1.3.0, CRS parameter is preferable but SRS is also supported.

Note that if both CRS and SRS parameters are indicated in the request, then it’s the current version indicated in VERSION parameter which is decisive.

In the next case, the SRS parameter is kept whatever the VERSION parameter because CRS is not indicated:

```
http://localhost/qgisserver?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0
&SRS=EPSG:2854
&...
```

In the next case, the SRS parameter is kept instead of CRS because of the VERSION parameter:

```
http://localhost/qgisserver?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.1.1
&CRS=EPSG:4326
&SRS=EPSG:2854
&...
```

In the next case, the CRS parameter is kept instead of SRS because of the VERSION parameter:

```
http://localhost/qgisserver?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0
&CRS=EPSG:4326
&SRS=EPSG:2854
&...
```

BBOX

This parameter allows to specify the map extent with units according to the current CRS. Coordinates have to be separated by a comma.

However, a slight difference has to be noticed according to the current VERSION parameter. In WMS 1.1.1, coordinates are formed like minx,miny,maxx,maxy or minlong,minlat,maxlong,maxlat. For example:

```
http://localhost/qgisserver?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.1.1
&SRS=epsg:4326
&BBOX=-180,-90,180,90
&...
```
But the axis is reversed in WMS 1.3.0, so coordinates are formed like miny, minx, maxy, maxx or minlat, minlong, maxlat, maxlong. For example:

```
http://localhost/qgisserver?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0
&CRS=epsg:4326
&BBOX=-90,-180,90,180
...
```

### WIDTH

This parameter allows to specify the width in pixels of the output image.

### HEIGHT

This parameter allows to specify the height in pixels of the output image.

### FORMAT

This parameter may be used to specify the format of map image. Available values are:

- `jpg`
- `jpeg`
- `image/jpeg`
- `image/png`
- `image/png; mode=1bit`
- `image/png; mode=8bit`
- `image/png; mode=16bit`
- `application/dxf` Only layers that have read access in the WFS service are exported in the DXF format.

URL example:

```
http://localhost/qgisserver?
SERVICE=WMS&VERSION=1.3.0
&REQUEST=GetMap
&FORMAT=application/dxf
&LAYERS=Haltungen,Normschacht,Spezialbauwerke
&CRS=EPSG%3A21781&BBOX=696136.28844801,245797.12108743,696318.91114315,245939.25832905
&WIDTH=1042
&HEIGHT=811
&FORMAT_OPTIONS=MODE:SYMBOL LAYERSYMBOLOLOGY;SCALE:250&FILE_NAME=plan.dxf
```
**TRANSPARENT**

This boolean parameter can be used to specify the background transparency. Available values are (not case sensitive):

- **TRUE**
- **FALSE**

However, this parameter is ignored if the format of the map image indicated with `FORMAT` is different from PNG.

**MAP**

This parameter allows to define the QGIS project file to use.

As mentioned in *GetMap parameters table*, `MAP` is mandatory because a request needs a QGIS project to actually work. However, the `QGIS_PROJECT_FILE` environment variable may be used to define a default QGIS project. In this specific case, `MAP` is not longer a required parameter. For further information you may refer to *Configuração avançada*.

**BGCOLOR**

This parameter allows to indicate a background color for the map image. However it cannot be combined with `TRANSPARENT` parameter in case of PNG images (transparency takes priority). The colour may be literal or in hexadecimal notation.

**URL example with the literal notation:**

```
http://localhost/qgisserver?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0
&BGCOLOR=green
&...
```

**URL example with the hexadecimal notation:**

```
http://localhost/qgisserver?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0
&BGCOLOR=0x00FF00
&...
```

**DPI**

This parameter can be used to specify the requested output resolution.

**IMAGE_QUALITY**

This parameter is only used for JPEG images. By default, the JPEG compression is -1.

You can change the default per QGIS project in the *OWS Server ➤ WMS capabilities* menu of the *Project ➤ Properties* dialog. If you want to override it in a *GetMap* request you can do it using the `IMAGE_QUALITY` parameter.
OPACITIES

Comma separated list of opacity values. Opacity can be set on layer or group level. Allowed values range from 0 (fully transparent) to 255 (fully opaque).

FILTER

A subset of layers can be selected with the FILTER parameter. The syntax is basically the same as for the QGIS subset string. However, there are some restrictions to avoid SQL injections into databases via QGIS Server. If a dangerous string is found in the parameter, QGIS Server will return the next error:

```
< ServiceExceptionReport>
  < ServiceException code="Security"> The filter string XXXXXXXXX has been rejected because of security reasons.
  Note: Text strings have to be enclosed in single or double quotes. A space between each word / special character is mandatory.
  Allowed Keywords and special characters are IS, NOT, NULL, AND, OR, IN, =, <, =<, >, =>, !=, ', (,), DMETAPHONE, SOUNDEX.
  Not allowed are semicolons in the filter expression. </ ServiceException>
</ ServiceExceptionReport>
```

URL example:

```
http://localhost/qgisserver?
SERVICE=WMS
&REQUEST=GetMap
&LAYERS=mylayer1,mylayer2,mylayer3
&FILTER=mylayer1:"col1";mylayer1,mylayer2:"col2" = 'blabla'
```

In this example, the same filter (field col2 equals the string blabla) is applied to layers mylayer1 and mylayer2, while the filter on col1 is only applied to mylayer1.

Nota: It is possible to make attribute searches via GetFeatureInfo and omit the X/Y parameter if a FILTER is there. QGIS Server then returns info about the matching features and generates a combined bounding box in the XML output.

SELECTION

The SELECTION parameter can highlight features from one or more layers. Vector features can be selected by passing comma separated lists with feature ids.

```
http://localhost/qgisserver?
SERVICE=WMS
&REQUEST=GetMap
&LAYERS=mylayer1,mylayer2
&SELECTION=mylayer1:3,6,9;mylayer2:1,5,6
...
```

The following image presents the response from a GetMap request using the SELECTION option e.g. http://myserver.com/...&SELECTION=countries:171,65.

As those features id’s correspond in the source dataset to France and Romania they’re highlighted in yellow.
FORMAT-OPTIONS

This parameter can be used to specify options for the selected format. Only for FORMAT=application/dxf. A list of key:value pairs separated by semicolon:

- SCALE: to be used for symbology rules, filters and styles (not actual scaling of the data - data remains in the original scale).
- MODE: corresponds to the export options offered in the QGIS Desktop DXF export dialog. Possible values are NOSYMBOL, FEATURESYMBOL and SYMBOLLAYERSYMBOL.
- LAYERSATTRIBUTES: specify a field that contains values for DXF layer names - if not specified, the original QGIS layer names are used.
- USE_TITLE_AS_LAYERNAME: if enabled, the title of the layer will be used as layer name.
- CODEC: specify a codec to be used for encoding. Default is ISO-8859-1 check the QGIS desktop DXF export dialog for valid values.
- NO_MTEXT: Use TEXT instead of MTEXT for labels.
- FORCE_2D: Force 2D output. This is required for polyline width.
For performance reasons, QGIS Server can be used in tiled mode. In this mode, the client requests several small fixed size tiles, and assembles them to form the whole map. Doing this, symbols at or near the boundary between two tiles may appeared cut, because they are only present in one of the tile.

Set the `TILED` parameter to `TRUE` to tell QGIS Server to work in `tiled` mode, and to apply the `Tile buffer` configured in the QGIS project (see Configure your project).

When `TILED` is `TRUE` and when a non-zero Tile buffer is configured in the QGIS project, features outside the tile extent are drawn to avoid cut symbols at tile boundaries.

`TILED` defaults to `FALSE`.

### 3.1.2 GetFeatureInfo

Standard parameters for the `GetFeatureInfo` request according to the OGC WMS 1.1.1 and 1.3.0 specifications:

<table>
<thead>
<tr>
<th>Parâmetros</th>
<th>Requerido</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVICE</td>
<td>Sim</td>
<td>Name of the service (WMS)</td>
</tr>
<tr>
<td>VERSION</td>
<td>Não</td>
<td>Version of the service</td>
</tr>
<tr>
<td>REQUEST</td>
<td>Sim</td>
<td>Name of the request (<code>GetFeatureInfo</code>)</td>
</tr>
<tr>
<td>QUERY_LAYERS</td>
<td>Sim</td>
<td>Layers to query</td>
</tr>
<tr>
<td>LAYERS</td>
<td>Sim</td>
<td>Layers to display (identical to <code>QUERY_LAYERS</code>)</td>
</tr>
<tr>
<td>STYLES</td>
<td>Não</td>
<td>Layers’ style</td>
</tr>
<tr>
<td>SRS / CRS</td>
<td>Sim</td>
<td>Coordinate reference system</td>
</tr>
<tr>
<td>BBOX</td>
<td>Não</td>
<td>Map extent</td>
</tr>
<tr>
<td>WIDTH</td>
<td>Sim</td>
<td>Width of the image in pixels</td>
</tr>
<tr>
<td>HEIGHT</td>
<td>Sim</td>
<td>Height of the image in pixels</td>
</tr>
<tr>
<td>TRANSPARENT</td>
<td>Não</td>
<td>Transparent background</td>
</tr>
<tr>
<td>INFO_FORMAT</td>
<td>Não</td>
<td>Output format</td>
</tr>
<tr>
<td>FEATURE_COUNT</td>
<td>Não</td>
<td>Maximum number of features to return</td>
</tr>
<tr>
<td>I</td>
<td>Não</td>
<td>Pixel column of the point to query</td>
</tr>
<tr>
<td>X</td>
<td>Não</td>
<td>Same as <code>I</code> parameter, but in WMS 1.1.1</td>
</tr>
<tr>
<td>J</td>
<td>Não</td>
<td>Pixel row of the point to query</td>
</tr>
<tr>
<td>Y</td>
<td>Não</td>
<td>Same as <code>J</code> parameter, but in WMS 1.1.1</td>
</tr>
<tr>
<td>WMS_PRECISION</td>
<td>Não</td>
<td>The precision (number of digits) to be used when returning geometry (see how to add geometry to feature response). The default value is ~1 meaning that the precision defined in the project is used.</td>
</tr>
</tbody>
</table>

In addition to the standard ones, QGIS Server supports the following extra parameters:

<table>
<thead>
<tr>
<th>Parâmetros</th>
<th>Requerido</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAP</td>
<td>Sim</td>
<td>Specify the QGIS project file</td>
</tr>
<tr>
<td>FILTER</td>
<td>Não</td>
<td>Subset of features</td>
</tr>
<tr>
<td>FI_POINT_TOLERANCE</td>
<td>Não</td>
<td>Tolerance in pixels for point layers</td>
</tr>
<tr>
<td>FI_LINE_TOLERANCE</td>
<td>Não</td>
<td>Tolerance in pixels for line layers</td>
</tr>
<tr>
<td>FI_POLYGON_TOLERANCE</td>
<td>Não</td>
<td>Tolerance in pixels for polygon layers</td>
</tr>
<tr>
<td>FILTER_GEOM</td>
<td>Não</td>
<td>Geometry filtering</td>
</tr>
<tr>
<td>WITH_MAPTIP</td>
<td>Não</td>
<td>Add map tips to the output</td>
</tr>
<tr>
<td>WITH_GEOMETRY</td>
<td>Não</td>
<td>Add geometry to the output</td>
</tr>
</tbody>
</table>

URL example:
REQUEST

This parameter is `GetFeatureInfo` in case of the `GetFeatureInfo` request.

INFO_FORMAT

This parameter may be used to specify the format of the result. Available values are:

- `text/xml`
- `text/html`
- `text/plain`
- `application/vnd.ogc.gml`
- `application/json`

QUERY_LAYERS

This parameter specifies the layers to display on the map. Names are separated by a comma.

In addition, QGIS Server introduces options to select layers by:

- `short name`
- `layer id`

See the `LAYERS` parameter defined in `GetMap` for more information.

FEATURE_COUNT

This parameter specifies the maximum number of features per layer to return. For example if `QUERY_LAYERS` is set to `layer1,layer2` and `FEATURE_COUNT` is set to 3 then a maximum of 3 features from layer1 will be returned. Likewise a maximum of 3 features from layer2 will be returned.

By default, only 1 feature per layer is returned.
This parameter, defined in WMS 1.3.0, allows you to specify the pixel column of the query point.

Same parameter as \texttt{I}, but defined in WMS 1.1.1.

This parameter, defined in WMS 1.3.0, allows you to specify the pixel row of the query point.

Same parameter as \texttt{J}, but defined in WMS 1.1.1.

This parameter specifies the tolerance in pixels for point layers.

This parameter specifies the tolerance in pixels for line layers.

This parameter specifies the tolerance in pixels for polygon layers.

This parameter specifies a WKT geometry with which features have to intersect.

This parameter specifies whether to add map tips to the output.

Available values are (not case sensitive):

\begin{itemize}
  \item \texttt{TRUE}
  \item \texttt{FALSE}
\end{itemize}

This parameter specifies whether to add geometries to the output. To use this feature you must first enable the \textit{Add geometry to feature response} option in the QGIS project. See \textit{Configure your project}.

Available values are (not case sensitive):

\begin{itemize}
  \item \texttt{TRUE}
  \item \texttt{FALSE}
\end{itemize}
3.1.3 GetPrint

QGIS Server has the capability to create print layout output in pdf or pixel format. Print layout windows in the published project are used as templates. In the GetPrint request, the client has the possibility to specify parameters of the contained layout maps and labels.

Parameters for the GetPrint request:

<table>
<thead>
<tr>
<th>Parâmetros</th>
<th>Requerido</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAP</td>
<td>Sim</td>
<td>Specify the QGIS project file</td>
</tr>
<tr>
<td>SERVICE</td>
<td>Sim</td>
<td>Name of the service (WMS)</td>
</tr>
<tr>
<td>VERSION</td>
<td>Não</td>
<td>Version of the service</td>
</tr>
<tr>
<td>REQUEST</td>
<td>Sim</td>
<td>Name of the request (GetPrint)</td>
</tr>
<tr>
<td>LAYERS</td>
<td>Não</td>
<td>Layers to display</td>
</tr>
<tr>
<td>TEMPLATE</td>
<td>Sim</td>
<td>Layout template to use</td>
</tr>
<tr>
<td>SRS / CRS</td>
<td>Sim</td>
<td>Coordinate reference system</td>
</tr>
<tr>
<td>FORMAT</td>
<td>Não</td>
<td>Output format</td>
</tr>
<tr>
<td>ATLAS_PK</td>
<td>Não</td>
<td>Atlas features</td>
</tr>
<tr>
<td>STYLES</td>
<td>Não</td>
<td>Layers’ style</td>
</tr>
<tr>
<td>TRANSPARENT</td>
<td>Não</td>
<td>Transparent background</td>
</tr>
<tr>
<td>OPACITIES</td>
<td>Não</td>
<td>Opacity for layer or group</td>
</tr>
<tr>
<td>SELECTION</td>
<td>Não</td>
<td>Highlight features</td>
</tr>
<tr>
<td>mapX:EXTENT</td>
<td>Não</td>
<td>Extent of the map ‘X’</td>
</tr>
<tr>
<td>mapX:LAYERS</td>
<td>Não</td>
<td>Layers of the map ‘X’</td>
</tr>
<tr>
<td>mapX:STYLES</td>
<td>Não</td>
<td>Layers’ style of the map ‘X’</td>
</tr>
<tr>
<td>mapX:SCALE</td>
<td>Não</td>
<td>Layers’ scale of the map ‘X’</td>
</tr>
<tr>
<td>mapX:ROTATION</td>
<td>Não</td>
<td>Rotation of the map ‘X’</td>
</tr>
<tr>
<td>mapX:GRID_INTERVAL_X</td>
<td>Não</td>
<td>Grid interval on x axis of the map ‘X’</td>
</tr>
<tr>
<td>mapX:GRID_INTERVAL_Y</td>
<td>Não</td>
<td>Grid interval on y axis of the map ‘X’</td>
</tr>
</tbody>
</table>

URL example:

http://localhost/qgisserver?
SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetPrint
&MAP=/home/qgis/projects/world.qgs
&CRS=EPSG:4326
&FORMAT=png
&map0:EXTENT=-180,-90,180,90
&map0:LAYERS=mylayer1,mylayer2,mylayer3
&map0:OPACITIES=125,200,125
&map0:ROTATION=45

Note that the layout template may contain more than one map. In this way, if you want to configure a specific map, you have to use mapX: parameters where X is a positive number that you can retrieve thanks to the GetProjectSettings request.

For example:

```xml
<WMS_Capabilities>
  ...
  <ComposerTemplates xsi:type="wms:_ExtendedCapabilities">
    <ComposerTemplate width="297" height="210" name="Druckzusammenstellung_1"/>
    <ComposerMap width="171" height="133" name="map0"/>
    <ComposerMap width="49" height="46" name="map1"/>
  </ComposerTemplates>
  ...
</WMS_Capabilities>
```
REQUEST

This parameter has to be GetPrint for the GetPrint request.

TEMPLATE

This parameter can be used to specify the name of a layout template to use for printing.

FORMAT

This parameter specifies the format of map image. Available values are:

- **png** (default value)
- **image/png**
- **jpg**
- **jpeg**
- **image/jpeg**
- **svg**
- **image/svg**
- **image/svg+xml**
- **pdf**
- **application/pdf**

If the FORMAT parameter is different from one of these values, then an exception is returned.

ATLAS_PK

This parameter allows activation of Atlas rendering by indicating which features we want to print. In order to retrieve an atlas with all features, the * symbol may be used (according to the maximum number of features allowed in the project configuration).

When FORMAT is pdf, a single PDF document combining the feature pages is returned. For all other formats, a single page is returned.

mapX:EXTENT

This parameter specifies the extent for a layout map item as xmin,ymin,xmax,ymax.

mapX:ROTATION

This parameter specifies the map rotation in degrees.
mapX:GRID_INTERVAL_X

This parameter specifies the grid line density in the X direction.

mapX:GRID_INTERVAL_Y

This parameter specifies the grid line density in the Y direction.

mapX:SCALE

This parameter specifies the map scale for a layout map item. This is useful to ensure scale based visibility of layers and labels even if client and server may have different algorithms to calculate the scale denominator.

mapX:LAYERS

This parameter specifies the layers for a layout map item. See GetMap Layers for more information on this parameter.

mapX:STYLES

This parameter specifies the layers’ styles defined in a specific layout map item. See GetMap Styles for more information on this parameter.

3.1.4 GetLegendGraphics

Several additional parameters are available to change the size of the legend elements:

- **BOXSPACE** space between legend frame and content (mm)
- **LAYERSPACE** vertical space between layers (mm)
- **LAYERTITLESPACE** vertical space between layer title and items following (mm)
- **SYMBOLSPACE** vertical space between symbol and item following (mm)
- **ICONLABELSPACE** horizontal space between symbol and label text (mm)
- **SYMBOLWIDTH** width of the symbol preview (mm)
- **SYMBOLHEIGHT** height of the symbol preview (mm)

These parameters change the font properties for layer titles and item labels:

- **LAYERFONTFAMILY / ITEMFONTFAMILY** font family for layer title / item text
- **LAYERFONTBOLD / ITEMFONTBOLD** TRUE to use a bold font
- **LAYERFONTSIZE / ITEMFONTSIZE** Font size in point
- **LAYERFONTTITALIC / ITEMFONTTITALIC** TRUE to use italic font
- **LAYERFONTCOLOR / ITEMFONTCOLOR** Hex color code (e.g. #FF0000 for red)
- **LAYERTITLE** FALSE to get only the legend graphics without layer title
- **RULELABEL:**
  - **FALSE** legend graphics without item labels
  - **AUTO** hide item label for layers with Single symbol rendering

Content based legend. These parameters let the client request a legend showing only the symbols for the features falling into the requested area:

- **BBOX** the geographical area for which the legend should be built
• **CRS / SRS** the coordinate reference system adopted to define the BBOX coordinates

• **SRCWIDTH / SRCHEIGHT** if set these should match the WIDTH and HEIGHT parameters of the GetMap request, to let QGIS Server scale symbols according to the map view image size.

Content based legend features are based on the [UMN MapServer implementation]:

• **SHOWFEATURECOUNT** if set to `TRUE` adds in the legend the feature count of the features like in the following image:

![Legend Example](image.png)

• **RULE** set it to a given rule name to get only the named rule symbol

• **WIDTH/HEIGHT** the generated legend image size if the **RULE** parameter is set

### 3.1.5 GetProjectSettings

This request type works similar to [GetCapabilities](#), but it is more specific to QGIS Server and allows a client to read additional information which is not available in the GetCapabilities output:

• initial visibility of layers

• information about vector attributes and their edit types

• information about layer order and drawing order

• list of layers published in WFS

• show if a group in the layer tree is mutually exclusive

### 3.2 Web Feature Service (WFS)

The **1.0.0** and **1.1.0** WFS standards implemented in QGIS Server provide an HTTP interface to query geographic features from a QGIS project. A typical WFS request defines the QGIS project to use and the layer to query.

Specifications document according to the version number of the service:

• **WFS 1.0.0**

• **WFS 1.1.0**

Standard requests provided by QGIS Server:

<table>
<thead>
<tr>
<th>Request</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetCapabilities</td>
<td>Returns XML metadata with information about the server</td>
</tr>
<tr>
<td>GetFeature</td>
<td>Returns a selection of features</td>
</tr>
<tr>
<td>DescribeFeatureType</td>
<td>Returns a description of feature types and properties</td>
</tr>
<tr>
<td>Transaction</td>
<td>Allows features to be inserted, updated or deleted</td>
</tr>
</tbody>
</table>
3.2.1 GetFeature

Standard parameters for the GetFeature request according to the OGC WFS 1.0.0 and 1.1.0 specifications:

<table>
<thead>
<tr>
<th>Parâmetros</th>
<th>Requerido</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVICE</td>
<td>Sim</td>
<td>Name of the service</td>
</tr>
<tr>
<td>VERSION</td>
<td>Não</td>
<td>Version of the service</td>
</tr>
<tr>
<td>REQUEST</td>
<td>Sim</td>
<td>Name of the request</td>
</tr>
<tr>
<td>TYPENAME</td>
<td>Não</td>
<td>Name of layers</td>
</tr>
<tr>
<td>OUTPUTFORMAT</td>
<td>Não</td>
<td>Output Format</td>
</tr>
<tr>
<td>RESULTTYPE</td>
<td>Não</td>
<td>Type of the result</td>
</tr>
<tr>
<td>PROPERTYNAME</td>
<td>Não</td>
<td>Name of properties to return</td>
</tr>
<tr>
<td>MAXFEATURES</td>
<td>Não</td>
<td>Maximum number of features to return</td>
</tr>
<tr>
<td>SRSNAME</td>
<td>Não</td>
<td>Coordinate reference system</td>
</tr>
<tr>
<td>FEATUREID</td>
<td>Não</td>
<td>Filter the features by ids</td>
</tr>
<tr>
<td>FILTER</td>
<td>Não</td>
<td>OGC Filter Encoding</td>
</tr>
<tr>
<td>BBOX</td>
<td>Não</td>
<td>Map Extent</td>
</tr>
<tr>
<td>SORTBY</td>
<td>Não</td>
<td>Sort the results</td>
</tr>
</tbody>
</table>

In addition to the standard ones, QGIS Server supports the following extra parameters:

<table>
<thead>
<tr>
<th>Parâmetros</th>
<th>Requerido</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAP</td>
<td>Sim</td>
<td>Specify the QGIS project file</td>
</tr>
<tr>
<td>STARTINDEX</td>
<td>Não</td>
<td>Paging</td>
</tr>
<tr>
<td>GEOMETRYNAME</td>
<td>Não</td>
<td>Type of geometry to return</td>
</tr>
<tr>
<td>EXP_FILTER</td>
<td>Não</td>
<td>Expression filtering</td>
</tr>
</tbody>
</table>

**SERVICE**

This parameter has to be WFS in case of the GetFeature request.

For example:

```
http://localhost/qgisserver?
SERVICE=WFS
&...
```

**VERSION**

This parameter allows to specify the version of the service to use. Available values for the VERSION parameter are:

- 1.0.0
- 1.1.0

If no version is indicated in the request, then 1.1.0 is used by default.

URL example:

```
http://localhost/qgisserver?
SERVICE=WFS
&VERSION=1.1.0
&...
```
REQUEST

This parameter is GetFeature in case of the GetFeature request.

URL example:

```
http://localhost/qgisserver?
SERVICE=WFS
&VERSION=1.1.0
&REQUEST=GetFeature
&...
```

RESULTTYPE

This parameter may be used to specify the kind of result to return. Available values are:

- results: the default behavior
- hits: returns only a feature count

URL example:

```
http://localhost/qgisserver?
SERVICE=WFS
&VERSION=1.1.0
&REQUEST=GetFeature
&RESULTTYPE=hits
&...
```

GEOMETRYNAME

This parameter can be used to specify the kind of geometry to return for features. Available values are:

- extensão
- centroid
- none

URL example:

```
http://localhost/qgisserver?
SERVICE=WFS
&VERSION=1.1.0
&REQUEST=GetFeature
&GEOMETRYNAME=centroid
&...
```

STARTINDEX

This parameter is standard in WFS 2.0, but it’s an extension for WFS 1.0.0. Actually, it can be used to skip some features in the result set and in combination with MAXFEATURES, it provides the ability to page through results.

URL example:

```
http://localhost/qgisserver?
SERVICE=WFS
&VERSION=1.1.0
&REQUEST=GetFeature
&STARTINDEX=2
&...
```
### 3.3 Web Map Tile Service (WMTS)

The **WMTS 1.0.0** standard implemented in QGIS Server provides a HTTP interface to request tiled map images generated from a QGIS project. A typical WMTS request defined the QGIS project to use, some WMS parameters like layers to render, as well as tile parameters.

Specifications document of the service:

- **WMTS 1.0.0**

Standard requests provided by QGIS Server:

<table>
<thead>
<tr>
<th>Request</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetCapabilities</td>
<td>Returns XML metadata with information about the server</td>
</tr>
<tr>
<td>GetTile</td>
<td>Returns a tile</td>
</tr>
<tr>
<td>GetFeatureInfo</td>
<td>Retrieves data (geometry and values) for a pixel location</td>
</tr>
</tbody>
</table>

#### 3.3.1 GetCapabilities

Standard parameters for the **GetCapabilities** request according to the OGC WMTS 1.0.0 specifications:

<table>
<thead>
<tr>
<th>Parâmetros</th>
<th>Requerido</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVICE</td>
<td>Sim</td>
<td>Name of the service (WMTS)</td>
</tr>
<tr>
<td>REQUEST</td>
<td>Sim</td>
<td>Name of the request (GetCapabilities)</td>
</tr>
</tbody>
</table>

In addition to the standard ones, QGIS Server supports the following extra parameters:

<table>
<thead>
<tr>
<th>Parâmetros</th>
<th>Requerido</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAP</td>
<td>Sim</td>
<td>Specify the QGIS project file</td>
</tr>
</tbody>
</table>

URL example:

```
http://localhost/qgisserver?
SERVICE=WMTS
&REQUEST=GetCapabilities
&MAP=/home/qgis/projects/world.qgs
```

**SERVICE**

This parameter has to be **WMTS** in case of the **GetCapabilities** request.

**REQUEST**

This parameter is **GetCapabilities** in case of the **GetCapabilities** request.
MAP

This parameter allows to define the QGIS project file to use.

3.3.2 GetTile

Standard parameters for the GetTile request according to the OGC WMTS 1.0.0 specifications:

<table>
<thead>
<tr>
<th>Parâmetros</th>
<th>Requerido</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVICE</td>
<td>Sim</td>
<td>Name of the service (WMTS)</td>
</tr>
<tr>
<td>REQUEST</td>
<td>Sim</td>
<td>Name of the request (GetTile)</td>
</tr>
<tr>
<td>LAYER</td>
<td>Sim</td>
<td>Layer identifier</td>
</tr>
<tr>
<td>FORMAT</td>
<td>Sim</td>
<td>Output format of the tile</td>
</tr>
<tr>
<td>TILEMATRIXSET</td>
<td>Sim</td>
<td>Name of the pyramid</td>
</tr>
<tr>
<td>TILEMATRIX</td>
<td>Sim</td>
<td>Meshing</td>
</tr>
<tr>
<td>TILEROW</td>
<td>Sim</td>
<td>Row coordinate in the mesh</td>
</tr>
<tr>
<td>TILECOL</td>
<td>Sim</td>
<td>Column coordinate in the mesh</td>
</tr>
</tbody>
</table>

In addition to the standard ones, QGIS Server supports the following extra parameters:

<table>
<thead>
<tr>
<th>Parâmetros</th>
<th>Requerido</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAP</td>
<td>Sim</td>
<td>Specify the QGIS project file</td>
</tr>
</tbody>
</table>

URL example:

```url
http://localhost/qgisserver?
SERVICE=WMTS
&REQUEST=GetTile
&MAP=/home/qgis/projects/world.qgs
&LAYER=mylayer
&FORMAT=image/png
&TILEMATRIXSET=EPSG:4326
&TILEROW=0
&TILECOL=0
```

SERVICE

This parameter has to be WMTS in case of the GetTile request.

REQUEST

This parameter is GetTile in case of the GetTile request.

LAYER

This parameter allows to specify the layer to display on the tile.

In addition, QGIS Server introduced some options to select a layer by:

- a short name
- the layer id

The short name of a layer may be configured through Properties ➤ Metadata in layer menu. If the short name is defined, then it’s used by default instead of the layer’s name:
Moreover, there’s a project option allowing to select layers by their id in OWS Server ▶ WMS capabilities menu of the Project ▶ Project Properties dialog. To activate this option, the checkbox Use layer ids as names has to be selected.

```
http://localhost/qgisserver?
SERVICE=WMTS
&REQUEST=GetTile
&LAYER=mynickname
&...
```

**FORMAT**

This parameter may be used to specify the format of tile image. Available values are:

- `jpg`
- `jpeg`
- `image/jpeg`
- `image/png`

If the FORMAT parameter is different from one of these values, then the default format PNG is used instead.

**TILEMATRIXSET**

This parameter defines the CRS to use when computing the underlying pyramid. Format: `EPSG:XXXX`.

**TILEMATRIX**

This parameter allows to define the matrix to use for the output tile.

**TILEROW**

This parameter allows to select the row of the tile to get within the matrix.

**TILECOL**

This parameter allows to select the column of the tile to get within the matrix.

**MAP**

This parameter allows to define the QGIS project file to use.

As mentioned in GetMap parameters table, MAP is mandatory because a request needs a QGIS project to actually work. However, the QGIS_PROJECT_FILE environment variable may be used to define a default QGIS project. In this specific case, MAP is not longer a required parameter. For further information you may refer to Configuração avançada.
### 3.3.3 GetFeatureInfo

Standard parameters for the `GetFeatureInfo` request according to the OGC WMTS 1.0.0 specification:

<table>
<thead>
<tr>
<th>Parâmetros</th>
<th>Requerido</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVICE</td>
<td>Sim</td>
<td>Name of the service (WMTS)</td>
</tr>
<tr>
<td>REQUEST</td>
<td>Sim</td>
<td>Name of the request (GetFeatureInfo)</td>
</tr>
<tr>
<td>LAYER</td>
<td>Sim</td>
<td>Layer identifier</td>
</tr>
<tr>
<td>INFOFORMAT</td>
<td>Não</td>
<td>Output format</td>
</tr>
<tr>
<td>I</td>
<td>Não</td>
<td>X coordinate of a pixel</td>
</tr>
<tr>
<td>J</td>
<td>Não</td>
<td>Y coordinate of a pixel</td>
</tr>
<tr>
<td>TILEMATRIXSET</td>
<td>Sim</td>
<td>See GetTile</td>
</tr>
<tr>
<td>TILEMATRIX</td>
<td>Sim</td>
<td>See GetTile</td>
</tr>
<tr>
<td>TILEROW</td>
<td>Sim</td>
<td>See GetTile</td>
</tr>
<tr>
<td>TILECOL</td>
<td>Sim</td>
<td>See GetTile</td>
</tr>
</tbody>
</table>

In addition to the standard ones, QGIS Server supports the following extra parameters:

<table>
<thead>
<tr>
<th>Parâmetros</th>
<th>Requerido</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAP</td>
<td>Sim</td>
<td>Specify the QGIS project file</td>
</tr>
</tbody>
</table>

URL example:

```
http://localhost/qgisserver?
SERVICE=WMTS
&REQUEST=GetFeatureInfo
&MAP=/home/qgis/projects/world.qgs
&LAYER=mylayer
&INFOFORMAT=image/html
&I=10
&J=5
```

**SERVICE**

This parameter has to be `WMTS` in case of the `GetFeatureInfo` request.

**REQUEST**

This parameter is `GetFeatureInfo` in case of the `GetFeatureInfo` request.

**MAP**

This parameter allows to define the QGIS project file to use.

As mentioned in *GetMap parameters table*, `MAP` is mandatory because a request needs a QGIS project to actually work. However, the `QGIS_PROJECT_FILE` environment variable may be used to define a default QGIS project. In this specific case, `MAP` is not longer a required parameter. For further information you may refer to *Configuração avançada*. 
LAYER

This parameter allows to specify the layer to display on the tile.

In addition, QGIS Server introduced some options to select a layer by:

- a short name
- the layer id

The short name of a layer may be configured through Properties ➤ Metadata in layer menu. If the short name is defined, then it’s used by default instead of the layer’s name:

```
http://localhost/qgisserver?
SERVICE=WMTS
&REQUEST=GetFeatureInfo
&LAYER=mynickname
&...
```

Moreover, there’s a project option allowing to select layers by their id in OWS Server ➤ WMS capabilities menu of the Project ➤ Project Properties dialog. To activate this option, the checkbox Use layer ids as names has to be selected.

```
http://localhost/qgisserver?
SERVICE=WMTS
&REQUEST=GetFeatureInfo
&LAYER=mylayerid1
&...
```

INFOFORMAT

This parameter allows to define the output format of the result. Available values are:

- texto/xml
- text/html
- text/plain
- application/vnd.ogc.gml

The default value is text/plain.

I

This parameter allows to define the X coordinate of the pixel for which we want to retrieve underlying information.

J

This parameter allows to define the Y coordinate of the pixel for which we want to retrieve underlying information.
3.4 WFS3 (OGC API Features)

WFS3 is the first implementation of the new generation of OGC protocols. It is described by the OGC API - Features - Part 1: Core document.

Here is a quick informal summary of the most important differences between the well known WFS protocol and WFS3:

- WFS3 is based on a REST API
- WFS3 API must follow the OPENAPI specifications
- WFS3 supports multiple output formats but it does not dictate any (only GeoJSON and HTML are currently available in QGIS WFS3) and it uses content negotiation to determine which format is to be served to the client
- JSON and HTML are first class citizens in WFS3
- WFS3 is self-documenting (through the /api endpoint)
- WFS3 is fully navigable (through links) and browsable

**Importante:** While the WFS3 implementation in QGIS can make use of the MAP parameter to specify the project file, no extra query parameters are allowed by the OPENAPI specification. For this reason it is strongly recommended that MAP is not exposed in the URL and the project file is specified in the environment by other means (i.e. setting QGIS_PROJECT_FILE in the environment through a web server rewrite rule).

**Nota:** The API endpoint provides comprehensive documentation of all supported parameters and output formats of your service. The following paragraphs will only describe the most important ones.

### 3.4.1 Resource representation

The QGIS Server WFS3 implementation currently supports the following resource representation (output) formats:

- HTML
- JSON

The format that is actually served will depend on content negotiation, but a specific format can be explicitly requested by appending a format specifier to the endpoints.

Supported format specifier extensions are:

- .json
- .html

Additional format specifier aliases may be defined by specific endpoints:

- .openapi: alias for .json supported by the API endpoint
- .geojson: alias for .json supported by the Features and Feature endpoints
3.4.2 Endpoints

The API provides a list of endpoints that the clients can retrieve. The system is designed in such a way that every response provides a set of links to navigate through all the provided resources.

Endpoints points provided by the QGIS implementation are:

<table>
<thead>
<tr>
<th>Name</th>
<th>Path</th>
<th>Descrição</th>
</tr>
</thead>
<tbody>
<tr>
<td>Landing Page</td>
<td>/</td>
<td>General information about the service and provides links to all available endpoints</td>
</tr>
<tr>
<td>Conformance</td>
<td>/conformance</td>
<td>Information about the conformance of the service to the standards</td>
</tr>
<tr>
<td>API</td>
<td>/api</td>
<td>Full description of the endpoints provided by the service and the returned documents structure</td>
</tr>
<tr>
<td>Collections</td>
<td>/collections</td>
<td>List of all collections (i.e. ‘vector layers’) provided by the service</td>
</tr>
<tr>
<td>Colletion</td>
<td>/collections/</td>
<td>Information about a collection (name, metadata, extent etc.)</td>
</tr>
<tr>
<td></td>
<td>{collectionId}</td>
<td></td>
</tr>
<tr>
<td>Feições</td>
<td>/collections/</td>
<td>List of the features provided by the collection</td>
</tr>
<tr>
<td></td>
<td>{collectionId}/items</td>
<td></td>
</tr>
<tr>
<td></td>
<td>{featureId}</td>
<td></td>
</tr>
</tbody>
</table>

**Landing Page**

The main endpoint is the **Landing Page**. From that page it is possible to navigate to all the available service endpoints. The **Landing Page** must provide links to

- the API definition (path /api link relations service-desc and service-doc),
- the Conformance declaration (path /conformance, link relation conformance), and
- the Collections (path /collections, link relation data).

![Fig. 3.2: Server WFS3 landing page](image)

QGIS Server
Available services
- Feature collections
- WFS 3.0 conformance classes
- API definition

powered by QGIS Server
API Definition

The **API Definition** is an OPENAPI-compliant description of the API provided by the service. In its HTML representation it is a browsable page where all the endpoints and their response formats are accurately listed and documented. The path of this endpoint is `/api`.

The API definition provides a comprehensive and authoritative documentation of the service, including all supported parameters and returned formats.

**Nota:** This endpoint is analogue to WFS's `GetCapabilities` operation.

Collections list

The collections endpoint provides a list of all the collections available in the service. Since the service "serves" a single QGIS project the collections are the vector layers from the current project (if they were published as WFS in the project properties). The path of this endpoint is `/collections/`.

![Collections list](image)

Fig. 3.3: Server WFS3 collections list page

Collection detail

While the collections endpoint does not provide detailed information about each available collection, that information is available in the `/collections/{collectionId}` endpoints. Typical information includes the extent, a description, CRSs and other metadata.

The HTML representation also provides a browsable map with the available features.
This endpoint provides a list of all features in a collection knowing the collection ID. The path of this endpoint is /collections/{collectionId}/items.

The HTML representation also provides a browsable map with the available features.

Nota: This endpoint is analogue to GetFeature in WFS 1 and WFS 2.
This endpoint provides all the available information about a single feature, including the feature attributes and its geometry. The path of this endpoint is /collections/{collectionId}/items/{itemId}.

The HTML representation also provides a browsable map with the feature geometry.

---

3.4. WFS3 (OGC API Features)
3.4.3 Pagination

Pagination of a long list of features is implemented in the OGC API through next and prev links, QGIS server constructs these links by appending limit and offset as query string parameters.

URL example:


Nota: The maximum acceptable value for limit can be configured with the QGIS_SERVER_API_WFS3_MAX_LIMIT server configuration setting (see: Variáveis ambientais).

3.4.4 Feature filtering

The features available in a collection can be filtered/searched by specifying one or more filters.

Date and time filter

Collections with date and/or datetime attributes can be filtered by specifying a datetime argument in the query string. By default the first date/datetime field is used for filtering. This behavior can be configured by setting a “Date” or “Time” dimension in the QGIS Server ▶ Dimension section of the layer properties dialog.

The date and time filtering syntax is fully described in the API Definition and also supports ranges (begin and end values are included) in addition to single values.

URL examples:

- Returns only the features with date dimension matching 2019-01-01
- Returns only the features with datetime dimension matching 2019-01-01T01:01:01
- Returns only the features with datetime dimension in the range 2019-01-01T01:01:01 - 2019-01-01T12:00:00
  http://localhost/qgissserver/wfs3/collection_one/items.json?datetime=2019-01-01T01:01:01/2019-01-01T12:00:00

Bounding box filter

A bounding box spatial filter can be specified with the bbox parameter:

The order of the comma separated elements is:

- Lower left corner, WGS 84 longitude
- Lower left corner, WGS 84 latitude
- Upper right corner, WGS 84 longitude
- Upper right corner, WGS 84 latitude
Nota: The OGC specifications also allow a 6 item bbox specifier where the third and sixth items are the Z components, this is not yet supported by QGIS server.

URL example:

http://localhost/qgisserver/wfs3/collection_one/items.json?bbox=-180,-90,180,90

If the CRS of the bounding box is not WGS 84, a different CRS can be specified by using the optional parameter bbox-crs. The CRS format identifier must be in the OGC URI format:

URL example:


Attribute filters

Attribute filters can be combined with the bounding box filter and they are in the general form: <attribute name>=<attribute value>. Multiple filters can be combined using the AND operator.

URL example:

filters all features where attribute name equals “my value”

http://localhost/qgisserver/wfs3/collection_one/items.json?attribute_one=my%20value

Partial matches are also supported by using a * (“star”) operator:

URL example:

filters all features where attribute name ends with “value”

http://localhost/qgisserver/wfs3/collection_one/items.json?attribute_one=*value

3.4.5 Feature sorting

It is possible to order the result set by field value using the sortby query parameter.

The results are sorted in ascending order by default. To sort the results in descending order, a boolean flag (sortdesc) can be set:

http://localhost/qgisserver/wfs3/collection_one/items.json?sortby=name&sortdesc=1

3.4.6 Attribute selection

The feature attributes returned by a Features list call can be limited by adding a comma separated list of attribute names in the optional properties query string argument.

URL example:

returns only the name attribute

http://localhost/qgisserver/wfs3/collection_one/items.json?properties=name
3.4.7 The HTML template language

The HTML representation uses a set of HTML templates to generate the response. The template is parsed by a template engine called **inja**. The templates can be customized by overriding them (see: [Template overrides](#)). The template has access to the same data that are available to the **JSON** representation and a few additional functions are available to the template:

### Custom template functions

- **path_append( path )**: appends a directory path to the current url
- **path_chomp( n )**: removes the specified number “n” of directory components from the current url path
- **json_dump( )**: prints the JSON data passed to the template
- **static( path )**: returns the full URL to the specified static path. For example: “static( “/style/black.css”)” with a root path “http://localhost/qgisserver/wfs3” will return “http://localhost/qgisserver/wfs3/static/style/black.css”.
- **links_filter( links, key, value )**: Returns filtered links from a link list
- **content_type_name( content_type )**: Returns a short name from a content type, for example “text/html” will return “HTML”

### Template overrides

Templates and static assets are stored in subdirectories of the QGIS server default API resource directory (`/usr/share/qgis/resources/server/api/` on a Linux system), the base directory can be customized by changing the environment variable **QGIS_SERVER_API_RESOURCES_DIRECTORY**.

A typical Linux installation will have the following directory tree:

```
/usr/share/qgis/resources/server/api/
|-- ogc
   |-- schema.json
   |-- static
       |-- jsonFormatter.min.css
       |-- jsonFormatter.min.js
       |-- style.css
       `-- templates
           |-- wfs3
               |-- describeCollection.html
               |-- describeCollections.html
               |-- footer.html
               |-- getApiDescription.html
               |-- getFeature.html
               |-- getFeatures.html
               |-- getLandingPage.html
               |-- getRequirementClasses.html
               |-- header.html
               |-- leaflet_map.html
               |-- links.html
```

To override the templates you can copy the whole tree to another location and point **QGIS_SERVER_API_RESOURCES_DIRECTORY** to the new location.
3.5 Extra parameters supported by all request types

The following extra parameters are supported by all protocols.

- **FILE_NAME**: if set, the server response will be sent to the client as a file attachment with the specified file name.

  **Nota**: Not available for WFS3.

- **MAP**: Similar to MapServer, the MAP parameter can be used to specify the path to the QGIS project file. You can specify an absolute path or a path relative to the location of the server executable (qgis_mapserv.fcgi). If not specified, QGIS Server searches for .qgs files in the directory where the server executable is located.

  Example:
  ```
  http://localhost/cgi-bin/qgis_mapserv.fcgi?
  REQUEST=GetMap&MAP=/home/qgis/projects/world.qgs&...
  ```

  **Nota**: You can define a **QGIS_PROJECT_FILE** as an environment variable to tell the server executable where to find the QGIS project file. This variable will be the location where QGIS will look for the project file. If not defined it will use the MAP parameter in the request and finally look at the server executable directory.

3.6 REDLINING

This feature is available and can be used with GetMap and GetPrint requests.

The redlining feature can be used to pass geometries and labels in the request which are overlapped by the server over the standard returned image (map). This permits the user to put emphasis or maybe add some comments (labels) to some areas, locations etc. that are not in the standard map.

The GetMap request is in the format:

```
http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi?map=/world.qgs&SERVICE=WMS&
\_<VERSION=1.3.0&
REQUEST=GetMap
...
\_<HIGHLIGHT_GEOM=POLYGON((590000 5647000, 590000 6110620, 2500000 6110620, 2500000
_\_<5647000, 590000 5647000))
\_<HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>
_\_<Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter
_\_<name="stroke">%23ea1173</SvgParameter><SvgParameter name="stroke-opacity">1</_\_<SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter><Stroke></Stroke>
_\_<LineSymbolizer></Rule></UserStyle></StyledLayerDescriptor>
\_<HIGHLIGHT_LABELSTRING=Write label here
\_<HIGHLIGHT_LABELSIZE=16
\_<HIGHLIGHT_LABELCOLOR=%23000000
\_<HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF
\_<HIGHLIGHT_LABELBUFFERSIZE=1.5
```

The GetPrint equivalent is in the format (note that mapX: parameter is added to tell which map has redlining):

```
http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi?map=/world.qgs&SERVICE=WMS&
\_<VERSION=1.3.0&
REQUEST=GetPrint
...
```
Here is the image outputed by the above request in which a polygon and a label are drawn on top of the normal map:

![Image of a map with a highlighted polygon and label](image)

**Fig. 3.7: Server response to a GetMap request with redlining parameters**

You can see there are several parameters in this request:

- **HIGHLIGHT_GEOM**: You can add POINT, MULTILINESTRING, POLYGON etc. It supports multipart geometries. Here is an example: `HIGHLIGHT_GEOM=MULTILINESTRING((0 0, 0 1, 1 1))`. The coordinates should be in the CRS of the GetMap/GetPrint request.

- **HIGHLIGHT_SYMBOL**: This controls how the geometry is outlined and you can change the stroke width, color and opacity.

- **HIGHLIGHT_LABELSTRING**: You can pass your labeling text to this parameter.
• **HIGHLIGHT_LABELSIZE**: This parameter controls the size of the label.

• **HIGHLIGHT_LABELFONT**: This parameter controls the font of the label (e.g. Arial)

• **HIGHLIGHT_LABELCOLOR**: This parameter controls the label color.

• **HIGHLIGHT_LABELBUFFERCOLOR**: This parameter controls the label buffer color.

• **HIGHLIGHT_LABELBUFFERSIZE**: This parameter controls the label buffer size.

### 3.7 External WMS layers

QGIS Server allows including layers from external WMS servers in WMS GetMap and WMS GetPrint requests. This is especially useful if a web client uses an external background layer in the web map. For performance reasons, such layers should be directly requested by the web client (not cascaded via QGIS server). For printing however, these layers should be cascaded via QGIS server in order to appear in the printed map.

External layers can be added to the LAYERS parameter as EXTERNAL_WMS:<layername>. The parameters for the external WMS layers (e.g. url, format, dpiMode, crs, layers, styles) can later be given as service parameters <layername>:<parameter>. In a GetMap request, this might look like this:

```
http://localhost/qgisserver?
SERVICE=WMS&REQUEST=GetMap
...&LAYERS=EXTERNAL_WMS:basemap,layer1,layer2
&STYLES=,
&basemap:url=http://externalserver.com/wms.fcgi
&basemap:format=image/jpeg
&basemap:crs=EPSG:2056
&basemap:layers=orthofoto
&basemap:styles=default
```

Similarly, external layers can be used in GetPrint requests:

```
http://localhost/qgisserver?
SERVICE=WMS&REQUEST=GetPrint&TEMPLATE=A4
...&map0:layers=EXTERNAL_WMS:basemap,layer1,layer2
&map0:EXTENT=<minx,miny,maxx,maxy>
&basemap:url=http://externalserver.com/wms.fcgi
&basemap:format=image/jpeg
&basemap:crs=EPSG:2056
&basemap:layers=orthofoto
&basemap:styles=default
```

### 3.8 QGIS Server Catalog

The QGIS Server Catalog is a simple catalog that shows the list of QGIS projects served by the QGIS Server. It provides a user-friendly fully browsable website with basic mapping capabilities to quickly browse the datasets exposed through those QGIS projects.

The QGIS Server catalog uses the variables `QGIS_SERVER_LANDING_PAGE_PROJECTS_DIRECTORIES` and `QGIS_SERVER_LANDING_PAGE_PROJECTS_PG_CONNECTIONS` (see `Variáveis ambientais`).
You can consult the metadata associated to a project and the services that it provides. Links to those services are also given.

By browsing a project, it is listed the dataset that it serves.
Use Right click on a layer to display the attribute table associated to it.

It is possible to consult information of the elements in the map as shown in the image below:
Fig. 3.12: Consulting information of a map element
4.1 Instalação

Para instalar o exemplo de plug-in HelloWorld para testar os servidores, você primeiro deve criar um diretório para armazenar os plugins do servidor. Isso será especificado na configuração do host virtual e passado ao servidor através de uma variável de ambiente:

```sh
mkdir -p /var/www/qgis-server/plugins
cd /var/www/qgis-server/plugins
wget https://github.com/elpaso/qgis-helloserver/archive/master.zip
unzip master.zip
mv qgis-helloserver-master HelloServer
```

4.2 Configuração do Servidor HTTP

4.2.1 Apache

Para poder usar os plugins do servidor, o FastCGI precisa saber onde procurar. Portanto, precisamos modificar o arquivo de configuração do Apache para indicar a variável de ambiente **QGIS_PLUGINPATH** ao FastCGI:

```apache
FcgidInitialEnv QGIS_PLUGINPATH "/var/www/qgis-server/plugins"
```

Além disso, uma basic authorization HTTP é necessária para brincar com o plug-in HelloWorld anteriormente introduzido. Portanto, precisamos atualizar o arquivo de configuração do Apache por último:

```apache
# Needed for QGIS HelloServer plugin HTTP BASIC auth
<IfModule mod_fcgid.c>
  RewriteEngine on
  RewriteCond %{HTTP:Authorization} .
  RewriteRule .* - [E=HTTP_AUTHORIZATION:%{HTTP:Authorization}]
</IfModule>
```

Em seguida, reinicie o Apache:

```bash
systemctl restart apache2
```
4.3 How to use a plugin

Test the server with the HelloWorld plugin:

```bash
wget -q -O - "http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=HELLO"
HelloServer!
```

You can have a look at the default GetCapabilities of the QGIS server at:

```bash
http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0& REQUEST=GetCapabilities
```
5.1 Registrando

To log requests sent to the server, you have to set the following environment variable:

- `QGIS_SERVER_LOG_STDERR`

With the following variables the logging can be further customized:

- `QGIS_SERVER_LOG_LEVEL`
- `QGIS_SERVER_LOG_PROFILE`

5.2 Variáveis ambientais

Você pode configurar alguns aspectos do QGIS Server configurando environment variables.

According to the HTTP server and how you run QGIS Server, there are several ways to define these variables. This is fully described in Apache HTTP Server.
<table>
<thead>
<tr>
<th>Nome</th>
<th>Descrição</th>
<th>Default</th>
<th>Services</th>
</tr>
</thead>
<tbody>
<tr>
<td>QGIS_OPTIONS_PATH</td>
<td>Specifies the path to the directory with settings. It works the same way as QGIS application --optionspath option. It is looking for settings file in &lt;QGIS_OPTIONS_PATH&gt;/QGIS/QGIS3.ini.</td>
<td>&quot;&quot;</td>
<td>All</td>
</tr>
<tr>
<td>QGIS_PLUGINPATH</td>
<td>Useful if you are using Python plugins for the server, this sets the folder that is searched for Python plugins.</td>
<td>&quot;&quot;</td>
<td>All</td>
</tr>
<tr>
<td>QGIS_PROJECT_FILE</td>
<td>The .qgs or .qgz project file, normally passed as a parameter in the query string (with MAP), you can also set it as an environment variable (for example by using mod_rewrite Apache module). Note that you may also indicate a project stored in PostgreSQL, e.g. postgresql://localhost:5432?s schema=myschema&amp;project=myproject.</td>
<td>&quot;&quot;</td>
<td>All</td>
</tr>
<tr>
<td>QGIS_SERVER_API_RESOURCES_DIRECTORY</td>
<td>Specifies the directories for all OGC API (such as OAPIF/WFS3) static resources (HTML templates, CSS, JS, ...).</td>
<td>depends on packaging</td>
<td>WFS</td>
</tr>
<tr>
<td>QGIS_SERVER_API_WFS3_MAX_LIMIT</td>
<td>Maximum number of features that can be requested in a single WFS request.</td>
<td>10000</td>
<td>WFS</td>
</tr>
<tr>
<td>QGIS_SERVER_CACHE_DIRECTORY</td>
<td>Specifies the network cache directory on the filesystem.</td>
<td>cache in profile directory</td>
<td>All</td>
</tr>
<tr>
<td>QGIS_SERVER_CACHE_SIZE</td>
<td>Sets the network cache size in MB.</td>
<td>50 MB</td>
<td>All</td>
</tr>
<tr>
<td>QGIS_SERVER_DISABLE_GETPRINT</td>
<td>Activating this option disables the QGIS WMS GetPrint request. Set this QGIS project flag to not load layouts.</td>
<td>false</td>
<td>WMS</td>
</tr>
<tr>
<td>QGIS_SERVER_IGNORE_BAD_LAYERS</td>
<td>&quot;Bad&quot; layers are layers that cannot be loaded. The default behavior of QGIS Server is to consider the project as not available if it contains a bad layer. The default behavior can be overridden by setting this variable to 1 or true. In this case, “bad” layers will just be ignored, and the project will be considered valid and available.</td>
<td>false</td>
<td>All</td>
</tr>
<tr>
<td>QGIS_SERVER_LANDING_PAGE_PROJECTS_DIRECTORIES</td>
<td>Directories used by the landing page service to find .qgs and .qgz projects                                                                ------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>/qgis/server_projects_directories</td>
<td></td>
</tr>
<tr>
<td>QGIS_SERVER_LANDING_PAGE_PROJECTS_PG_CONNECTIONS</td>
<td>PostgreSQL connection strings used by the landing page service to find projects                                                                ------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>/qgis/server_projects_pg_connections</td>
<td></td>
</tr>
<tr>
<td>QGIS_SERVER_LOG_FILE</td>
<td>Specify path and filename. Make sure that server has proper permissions for writing to file. File should be created automatically, just send some requests to server. If it’s not there, check permissions.</td>
<td>&quot;&quot;</td>
<td>All</td>
</tr>
</tbody>
</table>

**Aviso:**

QGIS_SERVER_LOG_FILE is deprecated since QGIS 3.4. File logging support
5.3 Settings summary

When QGIS Server is starting, you have a summary of all configurable parameters thanks to environment variables. Moreover, the value currently used and the origin is also displayed.

Por exemplo com spawn-fcgi:

```bash
export QGIS_OPTIONS_PATH=/home/user/.local/share/QGIS/QGIS3/profiles/default/
export QGIS_SERVER_LOG_STDERR=1
export QGIS_SERVER_LOG_LEVEL=2
spawn-fcgi -f /usr/lib/cgi-bin/qgis_mapserv.fcgi -s /tmp/qgisserver.sock -U www-
   →data -G www-data -n

QGIS Server Settings:

- QGIS_OPTIONS_PATH / '/' (Override the default path for user configuration): '/
   →home/user/.local/share/QGIS/QGIS3/profiles/default/' (read from ENVIRONMENT_  
   →VARIABLE)

- QGIS_SERVER_PARALLEL_RENDERING / '/qgis/parallel_rendering' (Activate/  
   →Deactivate parallel rendering for WMS getMap request): 'true' (read from INI_  
   →FILE)

- QGIS_SERVER_MAX_THREADS / '/qgis/max_threads' (Number of threads to use when_  
   →parallel rendering is activated): '4' (read from INI_FILE)

- QGIS_SERVER_LOG_LEVEL / '/' (Log level): '2' (read from ENVIRONMENT_VARIABLE)

- QGIS_SERVER_LOG_STDERR / '' (Activate/Deactivate logging to stderr): '1'_  
   →(read from ENVIRONMENT_VARIABLE)

- QGIS_PROJECT_FILE / '' (QGIS project file): '' (read from DEFAULT_VALUE)

- MAX_CACHE_LAYERS / '' (Specify the maximum number of cached layers): '100'_  
   →(read from DEFAULT_VALUE)

- QGIS_SERVER_CACHE_DIRECTORY / '/cache/directory' (Specify the cache_  
   →directory): '/root/.local/share/QGIS/QGIS3/profiles/default/cache' (read from_  
   →DEFAULT_VALUE)

- QGIS_SERVER_CACHE_SIZE / '/cache/size' (Specify the cache size): '52428800'_  
   →(read from INI_FILE)

Ini file used to initialize settings: /home/user/.local/share/QGIS/QGIS3/profiles/
   →default/QGIS/QGIS3.ini

In this particular case, we know that QGIS_SERVER_MAX_THREADS and  
QGIS_SERVER_PARALLEL_RENDERING values are read from the ini file found in  
QGIS_OPTIONS_PATH directory (which is defined through an environment variable). The corresponding  
entries in the ini file are /qgis/max_threads and /qgis/parallel_rendering and their values are true and 4 threads.
5.4 Short name for layers, groups and project

A number of elements have both a `<Name>` and a `<Title>`. The **Name** is a text string used for machine-to-machine communication while the **Title** is for the benefit of humans.

For example, a dataset might have the descriptive Title “Maximum Atmospheric Temperature” and be requested using the abbreviated **Name** “ATMAX”. The user can set the title for layers, groups and projects.

**OWS name** is based on the name used in the layer tree. This name is more a label for humans than a name for machine-to-machine communication. You can set a **Short name** for layers, groups or projects, to be used by QGIS Server as the layer identification name (in `LAYERS` parameter for instance).

You can set title, short name and abstract for:

- **Layers**: right-click on a layer and choose *Properties… ➤ QGIS Server ➤ Description*.
- **Groups**: right-click on a group and select *Set Group WMS data*

![Fig. 5.1: Set group WMS data dialog](image)

- **Project**: go to *Project ➤ Properties… ➤ QGIS Server ➤ Service Capabilities*.

5.5 Connection to service file

In order to make apache aware of the PostgreSQL service file (see the pg-service-file section) you need to make your `*.conf` file look like:

```
SetEnv PGSERVICEFILE /home/web/.pg_service.conf

<Directory "/home/web/apps2/bin/">
  AllowOverride None
  ......  
```

5.6 Add fonts to your linux server

Keep in mind that you may use QGIS projects that point to fonts that may not exist by default on other machines. This means that if you share the project, it may look different on other machines (if the fonts don’t exist on the target machine).

In order to ensure this does not happen you just need to install the missing fonts on the target machine. Doing this on desktop systems is usually trivial (double clicking the fonts).

For linux, if you don’t have a desktop environment installed (or you prefer the command line) you need to:

- On Debian based systems:
5.6. Add fonts to your Linux server

```
sudo su
mkdir -p /usr/local/share/fonts/truetype/myfonts && cd /usr/local/share/fonts/
  →truetype/myfonts

# copy the fonts from their location
cp /fonts_location/* .

chown root *
cd .. && fc-cache -f -v
```

- On Fedora based systems:

```
sudo su
mkdir /usr/share/fonts/myfonts && cd /usr/share/fonts/myfonts

# copy the fonts from their location
cp /fonts_location/* .

chown root *
cd .. && fc-cache -f -v
```
Capítulo 5. Configuração avançada
Development Server

A production installation and deployment of QGIS Server usually involves setting up a web server component (e.g. Apache or Nginx) that can forward the HTTP requests coming from the clients to the QGIS Server FastCGI binary application.

If you want to quickly test QGIS Server on your local machine without configuring and installing a full web server stack you can use the QGIS Development Standalone server.

This is an independent application that provides a very simple web server ready to serve your project files.

**Aviso:** The Standalone Development Server has not been developed with the purpose of being used in production, it was not checked for security vulnerabilities or for other stress conditions that normally will occur on a publicly exposed server.

To launch the server:

$ qgis_mapserver

The default port the Development Server listens to is 8000. Example output:

```
<table>
<thead>
<tr>
<th>IP Address</th>
<th>Timestamp</th>
<th>Request Time</th>
<th>Response Time</th>
<th>Request URL</th>
</tr>
</thead>
</table>
| 127.0.0.1  | [lun gen 20 15:16:41 2020] | 5140         | 103ms         | GET /wfs3/7MAP=/tests/testdata/qgis_server/test_project.qgs HTTP/1.1 | 200
| 127.0.0.1  | [lun gen 20 15:16:41 2020] | 3298         | 2ms           | GET /wfs3/static/jsonFormatter.min.js HTTP/1.1 | 200
| 127.0.0.1  | [lun gen 20 15:16:41 2020] | 1678         | 3ms           | GET /wfs3/static/style.css HTTP/1.1 | 200
```

The server has a few options that can be passed as command line arguments. You can see them all by invoking the server with `-h`.

**Usage:** `qgis_mapserver [options] [address:port]`

QGIS Development Server

(continua na próxima página)
Options:
- `h, --help` Displays this help.
- `v, --version` Displays version information.
- `-l <logLevel>` Sets log level (default: 0)
  - 0: INFO
  - 1: WARNING
  - 2: CRITICAL
- `-p <projectPath>` Path to a QGIS project file (*.qgs or *.qgz),
  if specified it will override the query string MAP argument
  and the QGIS_PROJECT_FILE environment variable

Arguments:
- `addressAndPort` Listen to address and port (default: "localhost:8000")
  address and port can also be specified with the environment
  variables QGIS_SERVER_ADDRESS and QGIS_SERVER_PORT
There are many ways to use containerized application, from the most simple (simple Docker images) to sophisticated (Kubernetes and so on).

**Nota:** This kind of deployment needs the `docker application` to be installed and running. Check this [tutorial](#).

**Dica:** Docker run pre packaged application (aka images) which can be retrieved as sources (Dockerfile and resources) to build or already built from registries (private or public).

**Nota:** QGIS Debian-Ubuntup package downloads need a valid gpg authentication key. Please refer to the [installation pages](#) to update the following Dockerfile with the latest key fingerprint

### 7.1 Simple docker images

As the docker image does not exist in a public registry, you will need to build it. To do so create a directory `qgis-server` and within its directory:

- create a file `Dockerfile` with this content:

```bash
FROM debian:buster-slim

ENV LANG=en_EN.UTF-8

RUN apt-get update \
    && apt-get install --no-install-recommends --no-install-suggests --allow-unauthenticated -y \
    gnupg \
    ca-certificates \
    wget \
    locales \
    && localedef -i en_US -f UTF-8 en_US.UTF-8 \
```

(continues on the next page)
# Add the current key for package downloading - As the key changes every year:

```bash
# Please refer to QGIS install documentation and replace it with the latest one
```n
```bash
apt-key add F7E06F06199EF2F2
```
```bash
echo "deb http://qgis.org/debian buster main" >> /etc/apt/sources.list.d/
```
```bash
apt-get update
```
```bash
apt-get install --no-install-recommends --no-install-suggests --allow-unauthenticated -y
```
```bash
```
```bash
apt-get remove --purge -y
```
```bash
rm -rf /var/lib/apt/lists/*
```

RUN useradd -m qgis

ENV TINI_VERSION v0.17.0
ADD https://github.com/krallin/tini/releases/download/$TINI_VERSION/tini /tini
RUN chmod +x /tini

ENV QGIS_PREFIX_PATH /usr
ENV QGIS_SERVER_LOG_STDERR 1
ENV QGIS_SERVER_LOG_LEVEL 2

COPY cmd.sh /home/qgis/cmd.sh
RUN chmod -R 777 /home/qgis/cmd.sh
RUN chown qgis:qgis /home/qgis/cmd.sh

USER qgis

WORKDIR /home/qgis

ENTRYPOINT ["/tini", "--"]

CMD ["/home/qgis/cmd.sh"]

• create a file cmd.sh with this content:

```bash
#!/bin/bash
[[ $DEBUG == "1" ]] && env
exec /usr/bin/xvfb-run --auto-servernum --server-num=1 /usr/bin/spawn-fcgi -p 5555 --n -d /home/qgis -- /usr/lib/cgi-bin/qgis_mapserv.fcgi
```

• build the image with:

```bash
docker build -f Dockerfile -t qgis-server ./
```

Capítulo 7. Containerized deployment
7.1.1 First run

To run the server you will need a QGIS project file. You can use one of yours or pick this sample.

To do so, create a directory `data` within the directory `qgis-server` and copy your file in it. To comply with the following explanations, rename it to `osm.qgs`.

Now, you can run the server with:

```
docker network create qgis
docker run -d --rm --name qgis-server --net=qgis --hostname=qgis-server \
  -v $(pwd)/data:/data:ro -p 5555:5555 \
  -e "QGIS_PROJECT_FILE=/data/osm.qgs" \
  qgis-server
```

Options used:

- `-d`: run in the background
- `--rm`: remove the container when it is stopped
- `--name`: name of the container to be created
- `--net`: (previously created) sub network
- `--hostname`: container hostname, for later referencing
- `-v`: local data directory to be mounted in the container
- `-p`: host/container port mapping
- `-e`: environment variable to be used in the container

To check, type `docker ps | grep qgis-server` and you should see a line with `qgis-server`:

```
<table>
<thead>
<tr>
<th>CONTAINER ID</th>
<th>IMAGE</th>
<th>COMMAND</th>
<th>CREATED</th>
<th>STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>4de8192da76e</td>
<td>qgis-server</td>
<td>&quot;/tini -- /home/qgis...&quot;</td>
<td>3 seconds ago</td>
<td>Up 2 seconds...</td>
</tr>
</tbody>
</table>
```

7.1.2 Usable sample

As the server is only accepting fastcgi connections, you need an HTTP server that handles this protocol. To do so we have to create a simple Nginx configuration file and start a Nginx image.

Create a file `nginx.conf` in the current directory with this content:

```
server {
  listen 80;
  server_name _;
  location / {
    root /usr/share/nginx/html;
    index index.html index.htm;
  }
  location /qgis-server {
    proxy_buffers 16 16k;
    proxy_buffer_size 16k;
    gzip off;
    include fastcgi_params;
    fastcgi_pass qgis-server:5555;
  }
}
```

And type this command:

```
```
To check capabilities availability, type in a browser http://localhost:8080/qgis-server/?SERVICE=WMS& VERSION=1.3.0&REQUEST=GetCapabilities

7.1.3 Cleanup

To cleanup the running images, type:

docker stop qgis-server nginx

7.2 Docker stacks

The previous method is scriptable, but not easily packageable nor standardized or easily manageable.

To work with a docker image set you could use a docker stack managed by an orchestrator. In a stack, the images are working in the same private network, and you can start / stop the whole stack or deploy the stack to other workers. There are many orchestrators, for example Swarm, Kubernetes and Mesos.

In the following, we will present simple configurations for testing purposes. They are not suitable for production.

7.2.1 Swarm/docker-compose

Docker now has its own orchestrator: Swarm (compatible with docker-compose files). You have to enable it (the Mac version will also work with Linux).

Stack description

Now that you have Swarm working, create the service file (see Deploy to Swarm) qgis-stack.yaml:

```yaml
version: '3.7'
services:
  qgis-server:
    # Should use version with utf-8 locale support:
    image: qgis-server:latest
    volumes:
      - REPLACE_WITH_FULL_PATH/data:/data:ro
    environment:
      - LANG=en_EN.UTF-8
      - QGIS_PROJECT_FILE=/data/osm.qgs
      - QGIS_SERVER_LOG_LEVEL=0 # INFO (log all requests)
      - DEBUG=1 # display env before spawning QGIS Server
  nginx:
    image: nginx:1.13
    ports:
      - 8080:80
    volumes:
      - REPLACE_WITH_FULL_PATH/nginx.conf:/etc/nginx/conf.d/default.conf:ro
    depends_on:
      - qgis-server
```

To deploy (or update) the stack, type:
docker stack deploy -c qgis-stack.yaml qgis-stack

Check the stack deployment status until you obtain 1/1 in the replicas column:

docker stack services qgis-stack

Something like:

<table>
<thead>
<tr>
<th>ID</th>
<th>IMAGE</th>
<th>NAME</th>
<th>PORTS</th>
<th>MODE</th>
<th>REPLICA</th>
</tr>
</thead>
<tbody>
<tr>
<td>gmx7ewvwsqt</td>
<td>nginx:1.13</td>
<td>qgis_qgis-server</td>
<td>*:8080-&gt;80/tcp</td>
<td>replicated</td>
<td>1/1</td>
</tr>
<tr>
<td>l0v2e7c143u3</td>
<td>--qgis-server:latest</td>
<td>qgis_qgis-server</td>
<td></td>
<td>replicated</td>
<td>1/1</td>
</tr>
</tbody>
</table>

To check WMS capabilities, type in a web browser [http://localhost:8080/qgis-server/?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities](http://localhost:8080/qgis-server/?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities)

**Cleanup**

To cleanup, type:

docker stack rm qgis-stack

### 7.2.2 Kubernetes

**Instalação**

If you have a [Docker Desktop](https://www.docker.com/products/docker-desktop) installation, using Kubernetes (aka k8s) is pretty straightforward: [enable k8s](https://kubernetes.io/docs/tasks/tools/install-kubectl/).

If not, follow the [minikube tutorial](https://minikube.sigs.k8s.io/docs/tutorials/) or [microk8s for Ubuntu](https://medium.com/@zetachan/microk8s-on-ubuntu-6e60e9892f2f).

As Kubernetes installation can be really complex, we will only focus on aspects used by this demo. For further / deeper information, check the [official documentation](https://kubernetes.io/docs/concepts/cluster-administration/).  

**microk8s**

microk8s needs extra steps: you have to enable the registry and tag the qgis-server image in order to have Kubernetes to find the created images.

First, enable the registry:

```
microk8s enable dashboard dns registry
```

Then, tag and push the image to your newly created registry:

```
docker tag qgis-server 127.0.0.1:32000/qgis-server
```

Finally, add or complete the `/etc/docker/daemon.json` to have your registry **127.0.0.1:32000** listed in the `insecure-registries` field:

```
{
  "insecure-registries": ["127.0.0.1:32000"]
}
```
Creating manifests

Kubernetes describes the objects to deploy in yaml manifests. There are many different kinds, but we will only use deployments (handle pods, i.e. docker images) and services to expose the deployments to internal or external purposes.

Deployment manifests

Create a file `deployments.yaml` with this content:

```yaml
apiVersion: apps/v1
kind: Deployment
metadata:
  name: qgis-server
  namespace: default
spec:
  replicas: 1
  selector:
    matchLabels:
      myLabel: qgis-server
  template:
    metadata:
      labels:
        myLabel: qgis-server
    spec:
      containers:
      - name: qgis-server
        image: localhost:32000/qgis-server:latest
        imagePullPolicy: IfNotPresent
        env:
          - name: LANG
            value: en_EN.UTF-8
          - name: QGIS_PROJECT_FILE
            value: /data/osm.qgs
          - name: QGIS_SERVER_LOG_LEVEL
            value: "0"
          - name: DEBUG
            value: "1"
        ports:
        - containerPort: 5555
      volumeMounts:
      - name: qgis-data
        mountPath: /data/
      volumes:
      - name: qgis-data
        hostPath:
          path: REPLACE_WITH_FULL_PATH/data
```
Service manifests

Create a file services.yaml with this content:

```yaml
apiVersion: v1
kind: Service
metadata:
  name: qgis-server
  namespace: default
spec:
  type: ClusterIP
  selector:
    myLabel: qgis-server
  ports:
  - port: 5555
    targetPort: 5555
---
apiVersion: v1
kind: Service
metadata:
  name: qgis-nginx
  namespace: default
spec:
  type: NodePort
  selector:
    myLabel: qgis-nginx
  ports:
  - port: 80
    targetPort: 80
    nodePort: 30080
```

Deploying manifests

To deploy the images and services in Kubernetes, one can use the dashboard (click on the + on the upper right) or the command line.

Nota: When using the command line with microk8s you will have to prefix each command with microk8s.

To deploy or update your manifests:
To check what is currently deployed:

```bash
kubectl get pods,services,deployment
```

You should obtain something like:

```
NAME                          READY STATUS  RESTARTS AGE
pod/qgis-nginx-54845ff6f6-8skp9 1/1    Running   0  27m
pod/qgis-server-75df8ddd89-c7t7s 1/1    Running   0  27m

NAME                        TYPE     CLUSTER-IP      EXTERNAL-IP PORT(S)   AGE
service/Kubernetes          ClusterIP 10.152.183.1   <none>     443/TCP    5h51m
service/qgis-exec-server    ClusterIP 10.152.183.218  <none>     5555/TCP   27m
service/qgis-nginx          NodePort   10.152.183.234  <none>     80:30080/TCP 27m

NAME                  READY UP-TO-DATE AVAILABLE AGE
deployment.apps/qgis-nginx 1/1   1          1     27m
deployment.apps/qgis-server 1/1   1          1     27m
```

To read nginx/qgis logs, type:

```bash
kubectl logs -f POD_NAME
```

To check WMS capabilities, type in a web browser `http://localhost:30080/qgis-server/?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities`

**Cleanup**

To clean up, type:

```bash
kubectl delete -n default service/qgis-server service/qgis-nginx deployment/qgis-nginx deployment/qgis-server
```

### 7.3 Cloud deployment

Managing your own cluster of servers to handle the deployment of containerized applications, is a complex job. You have to handle multiple issues, such as hardware, bandwidth and security at different levels.

Cloud deployment solutions can be a good alternative when you do not want to focus on infrastructure management.

A cloud deployment may use proprietary mechanisms, but they are also compatible with the stages explained previously (`docker images` and `stack management`).
7.3.1 AWS usecase

With Amazon AWS, through ECS (Elastic Container Service) functionalities, you can use docker-compose or Kubernetes compatible wrappers to manage your stack. You will have to create an image registry for your custom images to be accessible.

To use docker-compose alike functionalities, you need to install the ecs-cli client and have proper permissions / roles. Then, with the help of the ecs-cli compose commands (see the ecs-cli compose manual and ecs-cli tutorial), you can reuse the stack description.

To use Kubernetes, you can use the AWS web console or the command line tool eksctl and have the proper permissions / roles. Then with a well configured kubectl environment, you can reuse the Kubernetes manifests.
Frequently Asked Question

- **What are the differences between QGIS Desktop and QGIS Server?**

  QGIS Desktop has a graphical user interface and allows you to create and modify maps. QGIS Server is a server application serving your QGIS project files to end user applications via OGC web services like WMS, WFS, etc..

- **What is OGC?**

  The [OGC (Open Geospatial Consortium)](https://ogc.org) is an international not for profit organization committed to making quality open standards for the global geospatial community.

- **Name some other web mapping servers?**

  ArcGIS server, Geoserver, Mapserver, Mapnik etc.

- **How to compare QGIS server to other web mapping servers? (2021/01/01)**

<table>
<thead>
<tr>
<th>Features</th>
<th>QGIS Server</th>
<th>GeoServer</th>
<th>ArcGIS Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Since</td>
<td>2006</td>
<td>2001</td>
<td>1999</td>
</tr>
<tr>
<td>Licence</td>
<td>GPL</td>
<td>GPL</td>
<td>commercial</td>
</tr>
<tr>
<td>Commercial support</td>
<td>Multiple companies</td>
<td>Multiple companies</td>
<td>ESRI and its vendors network</td>
</tr>
<tr>
<td>Technology</td>
<td>C++/python</td>
<td>Java</td>
<td>C++</td>
</tr>
<tr>
<td>Tile cache</td>
<td>yes</td>
<td>yes (via GeoWebCache)</td>
<td>yes</td>
</tr>
<tr>
<td>3D</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Querying</td>
<td>FES (2.0) and OGC (1.0) filters</td>
<td>CQL and OGC filters</td>
<td>OGC filters</td>
</tr>
<tr>
<td>Report generation</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Server administration</td>
<td>yes via third parties (LizMap, QWC2, etc.)</td>
<td>web + API REST</td>
<td>web + API REST</td>
</tr>
<tr>
<td>GIS project Layer/symbology edition</td>
<td>complete via dedicated GUI</td>
<td>simple via web interface</td>
<td>complete via dedicated GUI</td>
</tr>
</tbody>
</table>

- **What are the OGC specification versions implemented in QGIS server compared to other web mapping servers? (2021/01/01)**
**What is a tile cache?**

Maps are often static. As most mapping clients render WMS (Web Map Service) data every time they are queried, this can result in unnecessary processing and increased wait times.

The tile cache optimizes this experience by saving (caching) map images, or tiles, as they are requested, in effect acting as a proxy between client (such as OpenLayers or Google Maps) and server (any WMS-compliant server). As new maps and tiles are requested, QGIS server intercepts these calls and returns pre-rendered tiles if stored, or calls the QGIS engine to render new tiles as necessary. Thus, once tiles are stored, the speed of map rendering increases by many times, creating a much improved user experience.

**What is PostgreSQL?**

PostgreSQL is a powerful, open source object-relational database companion for QGIS.

**What is PostGIS?**

PostGIS is a spatial database extender for PostgreSQL object-relational database. It adds support for geographic objects allowing location queries to be run in SQL.

• To be continued…